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Predslov
Geografické informačné systémy (GIS) je možné vnímať ako technologický prostriedok 

s konkrétnym využitím, resp. prostriedok vhodný na riešenie rôzneho spektra problémov 
viazaných na geografický  priestor. GIS sa odlišujú od ostatných informačných systémov 
práve schopnosťou pracovať s geografickým priestorom. Abstrakcia, analýza a vizualizácia 
priestoru je tým hlavným dôvodom, prečo sa GIS uplatňujú pri riešení rôznych problémov 
spojených s krajinnou sférou. V súčasnosti GIS ponúkajú používateľovi optimálne pracovné 
prostredie, ktoré je možné modifikovať podľa definovaných požiadaviek. K dispozícii je širo-
ké spektrum cenovo dostupného hardvérového vybavenia. Údajová báza je čoraz rýchlejšie 
aktualizovaná, pričom zároveň disponuje výraznejšou presnosťou obsiahnutých informácií. 
Metodológia práce je priamo previazaná s aplikačnou bázou a potrebou v danom sektore 
alebo oblasti využívania. V poslednom období sa silne rozvíja tzv. sociálna oblasť GIS, t. j. 
používateľská komunita, ktorá je združená do rôznych blogov, fór a sociálnych sietí. Taktiež 
sa posilňuje používateľská podpora zo strany GIS softvérových producentov, približujúca sa 
ku koncovému používateľovi, ktorý je aj na úrovni začiatočníka. GIS sa v takomto ponímaní 
stávajú ideálnou technológiou práce s geografickým priestorom a jeho obsahom.

Táto vysokoškolská učebnica sa venuje aplikačnej báze využívania GIS v  oblasti geo-
morfológie, hydrológie, 3D modelovania a krajinnej ekológie. Výstupy z uvedených oblastí 
je možné aplikovať priamo na riešenie problémov súvisiacich s ochranou a tvorbou krajiny, 
krajinného alebo územného plánovania, regionálneho rozvoja atď. Preto je v mnohých ohľa-
doch uprednostnený tzv. geografický prístup a súvisiaca terminológia pred technologickým 
a technickým opisom jednotlivých komponentov, z ktorých GIS pozostávajú. Bez zodpo-
vedajúcej technickej a technologickej infraštruktúry však nie je možné GIS použiť v oblasti 
aplikačného využívania, pre potreby ktorého je dôležitá disponibilita dostatočného hardvé-
rového výkonu a profesionálneho pracovného prostredia zo strany softvérových produktov. 
Aplikačné využívanie GIS je v tejto učebnici koncipované na softvérový produkt ArcGIS for 
Desktop 10.x.

Jednotlivé kapitoly prinášajú základný teoretický prehľad danej témy a pracovný po-
stup, ako použiť GIS na dosiahnutie požadovaných výsledkov. Ide najmä o analýzy viazané 
na reliéf, od ktorého sú odvodené jednotlivé parametre smerujúce napr. do oblasti 3D mo-
delovania alebo hydrológie. Vysokoškolská učebnica predstavuje určitý úvod a východisko-
vý bod tvorby konkrétnych cvičení. Kapitoly učebnice sú štruktúrované do logického rámca 
tak, aby si používateľ dokázal vyhotoviť požadovaný výsledok, napr. 3D animácie, výpočet 
krajinných metrík, odvodenie sklonov reliéfu atď. V učebnici je kladený dôraz na didaktickú 
stránku. Preto došlo k modifikácii zaužívanej terminológie, štruktúry a poradia informácií. 
Samotná obsahová podstata takto modifikovaných prístupov ostáva nezmenená.

Používateľ učebnice bude schopný samostatne pracovať s digitálnym modelom teré-
nu (DTM), dokáže odvodiť morfometrické parametre reliéfu, vytvoriť 3D model, vyhoto-
viť analýzu zmien krajinnej pokrývky atď. a následne previesť zručnosti do ďalších oblastí, 
v ktorých sa GIS využívajú.

Autori
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1. Priestorové analýzy v GIS
Kapitola je zameraná na aplikačné využívanie GIS pomocou priestorových analýz kraji-

ny. Sériou tematických okruhov sa pokúsime poukázať na možnosti využívania GIS v oblasti 
geografie, krajinnej ekológie, ekológie, ako aj ochrany krajiny. Jednotlivé tematické okruhy sú 
viazané na prácu s digitálnym modelom reliéfu a na prácu s krajinnou pokrývkou. 

Priestorové analýzy budeme v zmysle Haininga (2005) považovať za súbor metód urče-
ných na analýzu krajinného priestoru, t. j. na analýzu jeho prvkov a atribútov. Cieľom analýz 
bude hľadanie určitých vzťahov v priestore, ktoré je možné pre dané potreby interpretovať 
a následne vizualizovať. 

Výsledok priestorových analýz je podmienený vstupnými parametrami, ktoré sú repre-
zentované základnými vlastnosťami plynúcimi z geometrického, grafického a databázového 
rozhrania vstupných priestorových informácií. Hlavným účelom priestorových analýz je:

získanie presných parametrov a informácií na opis javov i udalostí v analyzovanom 1.	
priestore,

systematické skúmanie štruktúry, vzťahov, udalostí a vývoja v analyzovanom priesto-2.	
re s cieľom získať informácie o ich priebehu,

predvídanie a kontrolovanie javov a udalostí, ktoré prebiehajú v analyzovanom pries3.	
tore.

Podľa autorov Longley, Goodchild et al. (2005) je možné priestorové analýzy rozdeliť do 
nasledovných piatich okruhov:

Vyhľadávanie1.	  ako najčastejšie používaný typ priestorových analýz. V GIS sa využíva 
na zodpovedanie používateľom zostavených otázok vo vzťahu k databázovému roz-
hraniu priestorových informácií. Ide o analýzy, ktoré majú len tzv. dopytový charak-
ter, bez následnej zmeny údajovej a priestorovej štruktúry analyzovaných dát. Tento 
okruh priestorových analýz najčastejšie používa nástroje, ktoré vychádzajú z výrazov 
jazyka SQL.

Meranie prvkov analyzovaného priestoru pomocou číselných hodnôt. Ide o  čísel-2.	
né vyjadrenie dĺžky, plochy, vzdialenosti, uhla atď. medzi umiestnenými bodmi 
v priestore. Jednotlivé body sú zároveň uzlami, ktoré sú pospájané hranami do línie 
alebo polygónu. V prostredí GIS sú merania vo forme analýzy priestoru upravené 
o parametre príslušného zobrazovacieho systému, v ktorom práve pracujeme.

Transformácie prvkov analyzovaného priestoru, resp. ich zmena do požadovanej 3.	
podoby prostredníctvom spektra geoprocesingových nástrojov. Ide hlavne o  zme-
nu geometrie objektov, tvorbu syntetických dátových komplexov na základe priesto-
rového prieniku analytických dát. Do tohto okruhu zaraďujeme aj interpoláciu ana-
lyzovaného priestoru, prevody medzi dátovými modelmi, dátový manažment atď.

Sumarizačný opis analyzovaného priestoru pomocou matematicko-štatistických 4.	
operátorov. Výsledok je interpretovaný do podoby súčtov, min. a max. hodnôt, prie-
merov, odchýlok atď.

Lokalizácia5.	  konkrétneho miesta v  rámci analyzovaného priestoru podľa definova-
ných požiadaviek. Priestorové analýzy, ku ktorým sa pristupuje na syntetickej úrovni, 
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sú podmienené viacerými vstupnými údajmi. Ide napr. o optimalizáciu trasy precho-
du, vhodnosť umiestnenia objektov oddychu, športu, obchodu, služieb atď.

Priestorové analýzy je možné vnímať ako súbor pracovných metód a postupov s cieľom 
dosiahnuť stanovený výsledok. Pri priestorových analýzach môžeme pracovať s akýmkoľvek 
dátovým formátom. Zároveň prácu s nimi môžeme vzájomne kombinovať, tzn. na dociele-
nie požadovaného výsledku môžeme pracovať súčasne s vektorovým, ale aj rastrovým dáto-
vým modelom.

V prostredí ArcGIS máme pre aplikáciu ArcMap k dispozícii samostatné rozšírenie (ex-
tenziu) s  názvom Spatial Analyst. Rozšírenie ponúka spektrum nástrojov na priestorovú 
analýzu bunkovo orientovaných rastrových dátových modelov. Nástroje sú umiestnené pod-
ľa témy a účelu použitia, napr. nástroje viazané na analýzu: 

povrchu (•• Surface) pomocou digitálneho modelu reliéfu (priestorové interpolácie, 
analýzy sklonu a orientácie reliéfu voči svetovým stranám, atď.),

hustoty a rozptylu (Density) sledovaných javov alebo prvkov,••

povrchového a  podpovrchového odtokového režimu (•• Hydrology, Groundwater) 
atď.

Ďalší dôležitý súbor nástrojov priestorových analýz sa nachádza v rozšírení s názvom 3D 
Analyst. Rozšírenie je určené na prácu s 3D prvkami a priestorom. Vizualizácia sa uskutoč-
ňuje v samostatnej aplikácii ArcScene.

Využiteľnosť oboch extenzií spočíva predovšetkým v riešení environmentálne oriento-
vaných úloh v aplikáciách v oblasti ochrany prírody a krajiny, ďalej v odboroch lesníctva, 
civilného inžinierstva v priestore urbánnych aglomerácií, v ložiskovej geológii a v baníctve 
– pri vrtnom prieskume, v hydrológii a v protipovodňovej ochrane atď. 

Nástroje obidvoch rozšírení sa nachádzajú v samostatných lištách (Customize → Tool-
bars → Spatial Analyst a Customize → Toolbars → 3D Analyst), alebo sú tematicky uspo-
riadané v aplikácii  ArcToolbox.

Otázky:

Čo je priestorová analýza?1.	

Aký je hlavný účel priestorových analýz?2.	

Do akých okruhov sa priestorové analýzy rozdeľujú?3.	

Aké rozšírenie na prácu s priestorovými analýzami je k dispozícii  4.	
v prostredí aplikácie ArcMap?

Aký je rozdiel medzi rozšíreniami 5.	 Spatial Analyst a 3D Analyst?

Aký je rozdiel medzi aplikáciami 6.	 ArcScene a ArcMap?



8

2. Digitálny model terénu
Kapitola s názvom „Digitálny model terénu“ je zameraná na riešenie úloh abstrahovania 

reliéfu formou digitálneho dátového modelu so spojitým charakterom dát. Na tento účel je 
reliéf v zmysle Krcha (1973, 1991) považovaný za nehmotný prvok s pevným alebo dyna-
mickým fázovým rozhraním medzi atmosférou resp. hydrosférou na jednej strane a pedo-
sférou a biosférou či litosférou na strane druhej.

2.1. Teoretické východiská
Reliéf v zmysle Miklósa a Hrnčiarovej (1997) predstavuje geometrické pole, ktoré je vy-

tvorené priestorovým rozmiestnením bodov a charakterizované základným ukazovateľom, 
nadmorskou výškou v každom jednom bode zemského povrchu. Poloha konkrétneho bodu 
s nadmorskou výškou je zároveň definovaná súradnicami geografickej dĺžky a geografickej 
šírky. 

Prostredie aplikácie ArcMap poskytuje nástroje na tvorbu a správu dátových modelov, 
v ktorých sú obsiahnuté geografické informácie o reliéfe. Transformácia reálne existujúcich 
častí reliéfu do podoby digitálnych dátových modelov sa uskutočňuje prostredníctvom roz-
šírenia Spatial Analyst, 3D Analyst a Geostatistical Analyst. 

V takto vymedzenom kontexte transformácie sa podľa Čulákovej a Ofúkaného (2003) 
stretávame s nejednoznačnosťou vo výklade (či preklade) pojmov a skratiek. K dispozícii 
máme niekoľko terminológií, ktoré vyjadrujú obsahovú podstatu abstrakcie reliéfu do digi-
tálneho prostredia:

1.	 Digitálny výškový model – DVM (Digital Elevation Model – DEM). Zvyčajne je 
reprezentovaný ako dvojrozmerné pole „Z“ hodnôt, vzťahujúcich sa na spoločné de-
finovanie polohy (Frank et al., 2000). V DVM (DEM) môžu byť tiež zahrnuté prvky 
zemského povrchu, napr. budovy a porasty.

2.	 Digitálny model terénu – DMT (Digital Terrain Model – DTM). Ide o  digitálny 
model nadmorských výšok definujúci prvotný zemský povrch. Vylučuje prvky zem-
ského povrchu, napr. budovy, lesy atď. Slovo terén má korene v armáde a spravidla sa 
ním rozumie zemský povrch bez stavieb a vegetačného krytu (Šíma, 2002).

3.	 Digitálny model povrchu – DMP (Digital Surface Model – DSM). Zobrazuje vrchnú 
časť povrchu vrátane budov, lesov atď. Vyjadruje nielen zemský povrch, ale i povrch 
všetkých objektov na ňom (striech, korún stromov a pod.). Vzniká pri automatizova-
nom vyhodnotení leteckých snímok na princípe obrazovej korelácie (Šíma, 2002).

4.	 Digitálny model reliéfu – DMR je digitálna prezentácia reliéfu spojito sa menia-
ceho v priestore (Čuláková, 2002). Podľa českého „Terminologického slovníka země-
měřičství a katastru nemovitostí“ je DMR digitálna reprezentácia zemského povrchu 
v pamäti počítača zložená z dát a interpolačných algoritmov, ktoré umožňujú odvo-
dzovať výšky medziľahlých bodov. Podľa Krcha (1979) je DMR reprezentovaný ako 
súbor bodov reliéfu terénu vybraných podľa určitých pravidiel, polohovo lokalizo-
vaných s priradeným vektorom parametrov reliéfu. V USA má formu nepravidelne 
rozmiestnených výškových bodov, ktoré optimálne vystihujú terénne tvary vrátane 
hrán a výškových extrémov. Podľa Šúriho et al. (2003) DMR predstavuje množinu 
polohovo priradených údajov charakterizujúcich geometrické vlastnosti reliéfu (t. j. 
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nadmorskú výšku a  ďalšie morfometrické ukazovatele – sklon, orientáciu, krivosť 
reliéfu) a vypočítaných na základe vstupných výškových bodov a vhodnej interpo-
lačnej metódy. V technickej praxi, ako i v zahraničí, sa používa aj termín digitálny 
model terénu (DMT), ktorý je však čiastočne významovo odlišný, pretože implicitne 
neobsahuje aj morfometrické ukazovatele reliéfu a niekedy sa do neho zahŕňajú aj 
technické prvky v krajine (napr. cesty a zárezy). 

5.	 Digitálny model územia – DMÚ (Digital Landscape Model – DLM). Ide o základnú 
bázu geografických dát a súbor programových prostriedkov určených na zber, spra-
covanie, aktualizáciu a distribúciu geografických informácií o území. Ďalším použí-
vaným termínom je digitálny model krajiny – DMK (Šíma, 2002).

Na účely abstrahovania reliéfu do podoby geografických informácií (obrázok 1) budeme 
ďalej používať len termín digitálny model terénu – DMT (Digital Terrain Model – DTM).

Obrázok 1

V prostredí GIS je reliéf statickým objektom so spojitým informačným charakterom. In-
formácie o reliéfe môžeme abstrahovať do rastrových, ale aj vektorových dátových modelov, 
ktorými môžu byť:

Vrstevnice••  alebo sieť bodov – vektorový dátový model, t. j. vrstevnicový model. 
V takomto prípade ide o diskrétny typ údajov. Distribúcia prvkov v priestore vychá-
dza z výškového intervalu, ktorý určíme medzi vrstevnicami. 

TIN••  – špecifický dátový model tvorený nepravidelnou vektorovou sieťou susedia-
cich trojuholníkov. Výškové hodnoty sú priradené vrcholom trojuholníkov. V tomto 
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prípade ide o spojitý údajový typ, kde reliéf vymedzeného priestoru je abstrahovaný 
pomocou siete trojuholníkov rôznych rozmerov a tvarov.

GRID••  – rastrový dátový model, t. j. reliéf je reprezentovaný prostredníctvom pravi-
delnej siete buniek. Každá bunka má priradenú informáciu o nadmorskej výške.

2.2. Kvalitatívne požiadavky na dátový vstup
Tvorba digitálnych modelov reliéfu si vyžaduje určitý kvalitatívny dátový vstup. Vože-

nílek (2001) upozorňuje, že nie je možné vytvárať presné analýzy z nepresných dát. V geo-
grafických informáciách sú obsiahnuté neurčitosti a chyby, ktoré môžu ovplyvniť výsledky 
analýzy údajov a modelovania (Burrough, McDonnell, 1998). Takéto chyby sa môžu dostať 
do dát v rôznych štádiách spracovania geografických informácií, od merania geografické-
ho prostredia až po jeho prezentáciu v  prostredí GIS (Čuláková,  Ofúkaný 2003). Kvalita 
priestorových údajov závisí najmä od použitej terminológie, zberu dát a vychádza z nasle-
dujúcich atribútov (Frank et al., 2000):

pôvod priestorových dát – opis zdroja a použitej metódy odvodenia,••

polohová presnosť (horizontálna a vertikálna) – závisí od skúseností v meraní,••

použité metódy a výber mapovej projekcie,••

atribútová presnosť – zmena daného javu, presnosť meracieho prístroja a merania,••

kompletnosť – opis vzťahov medzi objektmi,••

logická konzistencia – vernosť vzťahov zakódovaných v údajovej štruktúre digitál-••
nych priestorových dát,

sémantická presnosť – význam geografického objektu v realite,••

časová informácia – dátum pozorovania, typ aktualizácie, časové obdobie platnosti ••
záznamu priestorových dát.

Tvorba digitálnych modelov reliéfu pomocou analógových informácií z výškopisu topo-
grafických máp môže byť podľa Čulákovej a Ofúkaného (2003) vo svojej podstate zaťažená 
chybami. Veľmi časté sú chyby v  nepresnej polohe vrstevníc identických výšok na styku 
dvoch mapových listov. Podľa Voženílka (2001) môže ísť o nasledovné typy chýb:

omyly (blunders) – sú ľahko identifikovateľné a treba ich vylúčiť ešte pred vstupom ••
dát do procesu spracovania DTM,

systematické chyby (systematic errors) – je potrebné eliminovať umelé nereálne tvary ••
reliéfu (vertikálny posun výšok, fiktívne vrcholy, zlomy) spôsobené vrchnou časťou 
povrchu (napr. koruny stromov),

náhodné chyby (randoms) – bežná distribúcia chýb v priestore, ktoré môžu mať po-••
zitívny, ale aj negatívny charakter a rôznu početnosť. 
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2.3. Dátový vstup 
Digitálny model terénu musí reprezentovať reálne existujúci reliéf, ktorý je matematicky 

a geograficky definovaný. Získavanie primárnych informácií na tvorbu DTM môžeme podľa 
Bitterera (2003) vykonať troma spôsobmi:

geodetickým meraním v teréne, ktoré sa uskutočňuje spravidla elektronickou tachy-••
metriou,

fotogrametrickým vyhodnotením leteckých snímok, ktoré sa dnes považuje za hlav-••
nú metódu tvorby DTM,

vektorizáciou obsahu existujúcich máp, ktorá je založená na určovaní terénnych bo-••
dov z výškopisnej zložky mapy. Do vektorovej podoby môžeme abstrahovať líniové 
alebo bodové objekty mapy. 

V prípade výberu bodov pre DTM sa ich hustota a rozloženie riadi charakterom terénu. 
Počet bodov nemôžeme presne vymedziť, aj keď sú vypracované optimálne počty bodov 
rôznych typov terénu, napr. jednoduchý terén a pravidelne členitý terén s 20 až 40 bodmi/ha, 
resp. nepravidelný, veľmi členitý terén so 100 až 400 bodmi/ha atď. (Bitterer, 2003). 

2.4. Interpolačné metódy
Transformácia polohopisných geografických informácií na DTM sa uskutočňuje 

prostredníctvom spektra algoritmov, resp. interpolačných metód. Vstupné polohopisné 
informácie (vrstevnice alebo výškové body) majú diskrétny charakter s  rôznou hustotou 
a priestorovou distribúciou. Priestor, ktorý nemá výškovú reprezentáciu (obrázok 2), je do-
pĺňaný pomocou interpolačných algoritmov (v prípade výpočtu výšok v hraniciach vyme-
dzených existujúcimi vstupnými údajmi) alebo extrapolačnými algoritmami (pri výpočte 
výšok mimo oblasti vstupných údajov, napr. pri doplnení tvaru spracovávanej oblasti na 
pravouholník). Z praktického hľadiska ide hlavne o priestor medzi vrstevnicami alebo výš-
kovými bodmi. Zvolená metóda tento prázdny priestor doplní podľa hodnôt z najbližšie sa 
nachádzajúcich výškových reprezentácií. V  prostredí ArcMap sú k  dispozícii nasledovné 
typy interpolovacích a  extrapolovacích algoritmov, ktoré je možné charakterizovať podľa 
viacerých autorov, napr. Voženílka (2001), Čulákovej a Ofúkaného (2003) atď.:

Obrázok 2



12

1.	 Inverse Distance Weighting (IDW) 
– metóda inverzných vzdialeností (ob-
rázok 3), pri ktorej sa uplatňuje základ-
ný geoštatistický princíp. Javy, ktoré sú 
v priestore bližšie k  sebe, sa viac podo-
bajú ako javy, ktoré sú priestorovo vzdia-
lenejšie. IDW je metóda interpolácie, 
ktorá odhaduje hodnoty buniek po-
mocou priemeru známych hodnôt 
v susedstve každej bunky. Vplyv zná-
mych hodnôt slabne so vzdialenos-
ťou, t. j. váha bodov (mocnina) je 
nepriamo úmerná ich vzdialenosti. 
Metódou IDW je problematické inter-
polovať vrcholy alebo  údolia. Odhado-
vané hodnoty nebudú vyššie ani nižšie 
ako hodnoty vstupu, preto nemôžu byť 
správne. Pokiaľ nemáme k dispozícii mi-
nimálne a maximálne hodnoty interpo-
lovaného javu, resp. priestoru, dochádza 
v  týchto miestach k  skresleniu. Ďalším 
významným nedostatkom metódy IDW 
je tvorba koncentrických izolínií (bull 
eyes) okolo vstupných bodov.

2.	 Spline – metóda využíva matematicky 
definované krivky (obrázok 4), ktoré in-
terpolujú jednotlivé časti povrchu. Vý-
sledný povrch presne prechádza bod-
mi so známymi hodnotami. Metódu je 
možné prirovnať ku gumenej ploche, kto-
rú ohýbame v nami zvolených miestach, 
t. j. v  známych bodoch. Výhodou tejto 
metódy je, že sa môžu modifikovať čas-
ti terénu, inak by sa musel prepočítavať 
povrch. Zároveň dochádza k interpolácii 
vrcholov a údolí. Nevýhodou však je, že 
výsledný reliéf je nerealisticky hladký 
vďaka vyhladeniu bariér a  skokov. Naj-
lepšie výsledky môžeme dosiahnuť pri 
interpolácii veľmi hladkých povrchov, 
napr. klimatických javov. Zároveň ju mô-
žeme použiť na vyhladzovanie povrchov. 
Na obrázku 5 je graficky znázornený roz-
diel medzi metódami IDW a Spline.

3.	 Trend – v prípade interpolácie spojitého 
javu môžeme neznáme hodnoty vypočítať 
polynomickou funkciou (obrázok 6), tzv. Obrázok 6

Obrázok 5

Obrázok 4

Obrázok 3
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trendom. Interpolácia trendom prispôso-
buje povrch množine bodov pri použití 
viacnásobnej (polynomickej) regresie. 
Výsledný povrch neprechádza žiadnym zo 
vstupných bodov.

4.	 Kriging – je podobná metóda ako IDW, 
avšak v prípade IDW váhy závisia výlučne 
na vzdialenosti od odhadovaného miesta. 
Pri metóde kriging (obrázok 7) závisia váhy 
aj na priestorovom usporiadaní interpolova-
ného priestoru. Metóda vychádza z algorit-
mov IDW, t. j. z váženého priemeru priestorovej premennej (vstupných známych hodnôt), 
ktorej váhy sú spočítané na základe variogramu. Podľa Blištána a Pauca (2005) je možné 
variogram zostaviť z dvojice hodnôt oddelených vektorovou líniou. Pôvodné hodnoty sa 
pri konštrukcii variogramu transformujú hodnotou 1, ak spĺňajú stanovenú podmienku, 
napr. nadmorská výška je 780 m. V prípade, že hodnoty presahujú stanovený limit, nahrá-
dzajú sa hodnotou 0. Transformované pole hodnôt slúži ako vstup interpolácie metódou 
kriging. Je to exaktná metóda interpolácie a pokiaľ nie je podiel neznámej hodnoty veľký, 
poskytuje veľmi presné výsledky. Výpočtovo je však značne náročný.

5.	 Natural Neighbor – interpolačná metóda, kde nie je možné zadať spresňujúce para-
metre, ktoré by ovplyvnili výsledok. Využíva techniky priestorovej lokalizácie hodnôt 
susedných buniek. Interpolácia prebieha iba vo vnútornom priestore, ktorý vznik-
ne pospájaním hraničných bodov do tzv. konvexného polygónu. Metódu je možné 
aplikovať v rôznej triede kvalitatívneho vstupu, napr. body rozptýlené, rovnomerné, 
husté alebo riedke. Výsledkom interpolácie je raster, v ktorom sú hodnoty spojito 
previazané a zároveň vyhladené. 

6.	 Topo to Raster – špecifická metóda produktu ArcGIS, ktorá je určená na interpolá-
ciu tzv. hydrologicky korektného digitálneho modelu terénu. Topo to Raster dovoľuje 
modelovať náhle zmeny v priebehu nadmorskej výšky. Metóda vychádza z kombi-
nácie algoritmov IDW a Spline. Do interpolácie vstupujú okrem výškových bodov 
aj hydrologické vrstvy, ako sú napr. povodia, vodné plochy alebo vodné toky. Výškové 
informačné vstupy, ktoré budú v rozpore s hydrologickým vstupom, budú ignorova-
né, t. j. zohľadňujú sa polohopisné informácie o priestore. 

Termín interpolácia vyjadruje proces výpočtu neznámych hodnôt určitého javu na zákla-
de množiny známych hodnôt. Interpolačný proces je možné aplikovať len vtedy, ak je daný 
jav spojitý a priestorovo závislý. Výsledok 
interpolácie sledovaného javu je podmie-
nený kvantitatívnym i kvalitatívnym vstu-
pom a  voľbou správneho interpolačného 
algoritmu. Týmto spôsobom môžeme 
odhadnúť akékoľvek hodnoty, ktoré majú 
geografickú bázu reprezentácie a  šírenia, 
napr. nadmorskú výšku, kontamináciu 
zložiek životného prostredia, hluk, dažďo-
vé zrážky atď. Na tento účel je priložený 
porovnávajúci obrázok 8. 

Obrázok 7

Obrázok 8
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2.5. Digitálny model terénu v ArcMap
Digitálny model terénu môžeme vytvoriť v  prostredí aplikácie ArcMap viacerými in-

terpolačnými metódami. Funkcionalita nástrojov, ktoré sú určené na prácu s  rastrovými 
dátovými modelmi, je viazaná na rozšírenia Spatial Analyst,  3D Analyst a  Geostatistical 
Analyst. 

Primárnym dátovým vstupom do tvorby digitálneho modelu terénu sú bodové prvky 
vektorových dátových modelov. Ide o veľmi jednoduchý pracovný postup, ktorý je podmie-
nený správnym nastavením parametrov interpolačných algoritmov. Základom je vektorový 
vstup bodovej vrstvy s obsahom atribútového záznamu „Z“ hodnôt, resp. súradníc, ktoré 
reprezentujú nadmorskú výšku. Podľa zadanej výškovej hodnoty a nastavených parametrov 
vytvárame digitálny model terénu. Na obrázku 9 je znázornený digitálny model terénu po-
mocou mapového podkladu s vrstvami výškovej reprezentácie. 

Obrázok 9

2.5.1. Inverse Distance Weighting (IDW) 
Interpoláciu povrchu pomocou algoritmu IDW môžeme vykonať položkou IDW apli-

kácie ArcToolbox (Spatial Analyst Tools → Interpolation → IDW). V zobrazenom okne 
máme k dispozícii niekoľko možností nastavenia parametrov (obrázok 10): 

Input point features••  – vrstva vstupných bodov (známa reprezentácia priestoru), kto-
rá obsahuje atribút s nadmorskou výškou.

Z value field••  – výber atribútu s obsahom hodnôt nadmorských výšok.

Output raster••  – výsledná interpolácia povrchu v rastrovom dátovom formáte.

Output cell size (optional)••  – veľkosť bunky výsledného rastra.

Power (optional)••  – mocnina váhy; čím je vyššie číslo, tým bude bližším bodom prira-
dená väčšia váha. So zvýrazneným detailom sa znižuje aj hladkosť číselnej spojitosti 
nadmorských výšok. Menšie číslo kladie dôraz na vzdialenejšie body a výsledok bude 
menej detailný, t. j. zvýrazní sa hladkosť prechodu nadmorských výšok. Hodnoty 
mocniny sa zadávajú v rozsahu od 0.5 do 3. V prípade hodnoty 0 bude odhad rovný 
aritmetickému priemeru. Štandardne je prednastavená hodnota 2. 
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Search radius (optional)••  – nastavenie 
priestorového polomeru, ktorý obme-
dzuje počet vstupných bodov na výpočet 
odhadu neznámeho priestoru. Polomer 
vyhľadávacieho priestoru môže byť pev-
ný (Fixed) alebo variabilný (Variable):

Fixed••  – je potrebné zadať veľkosť 
(polomer) kruhu (Distance), v kto-
rom sa bude vyhľadávať minimálny 
počet vstupných bodov (Minimum 
number of points). Všetky body 
v definovanej vzdialenosti budú po-
užité na výpočet neznámeho priesto-
ru. Ide o kombináciu veľkosti plochy 
a počtu bodov. V prípade menšieho 
počtu bodov v  danom priestore sa 
bude polomer kruhu zväčšovať. Za-
daný polomer bude použitý pre kaž-
dý známy bod. V takomto prípade je polomer nadradený počtu bodov, ktoré ne-
musíme zadávať. Polomer je štandardne nastavený päťnásobkom veľkosti pixlov 
vstupného rastra (obrázok 11). 

Variable •• – je potrebné zadať počet vstupných bodov (Number of points) a maxi-
málny možný vyhľadávací polomer kruhového priestoru (Maximum distance), 
v ktorom sa bude realizovať interpolácia. Zadaný maximálny polomer je priamo 
závislý na počte bodov. Ak sa dosiahne požadovaný počet bodov, berie sa do úva-
hy len aktuálne dosiahnutý polomer. Počet bodov je štandardne nastavený na 12 
(obrázok 12). 

Input barrier polyline features (optional)••  – bariéra v podobe líniovej vrstvy (útes, 
vodopád atď.), ktorá obmedzuje vyhľadávanie vstupných bodov (obrázok 13). 

Obrázok 11 Obrázok 12 Obrázok 13

2.5.2. Spline
Interpoláciu povrchu pomocou algoritmu Spline môžeme vykonať položkou Spline apli-

kácie ArcToolbox (Spatial Analyst Tools → Interpolation → Spline). V zobrazenom okne 
máme k dispozícii niekoľko možností nastavenia parametrov (obrázok 14): 

Obrázok 10
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Input point features••  – vrstva vstup-
ných bodov (známa reprezentácia 
priestoru), ktorá obsahuje atribút 
s nadmorskou výškou.

Z  value field••  – výber atribútu 
s  obsahom hodnôt nadmorských 
výšok.

Output raster••  – výsledná interpo-
lácia povrchu v  rastrovom dáto-
vom formáte.

Output cell size (optional)••  – veľkosť 
bunky výsledného rastra.

•• Spline type (optional) – výber me-
tódy zakrivenia interpolovaného po
vrchu. Prvá metóda je tzv. regulovaná (REGULARIZED) a  vytvára vyhladený povrch 
aj mimo rozsahu vstupných hodnôt. Druhá metóda (TENSION) kladie dôraz na rozsah 
vstupných hodnôt, čím sa vytvára menej hladký povrch, ktorý môže byť sprevádzaný rôz-
nymi kontrastmi.

Weight (optional) •• – vybranej metóde zadávame tzv. váhu, ktorá ovplyvňuje interpo-
lačný proces resp. krivosť výsledného povrchu. 

V prípade regulovanej voľby (•• REGULARIZED) sa uplatňuje pravidlo, čím vyššia 
je váha, tým vzniká menšia krivosť a výsledná štruktúra je hladšia. Hodnota para-
metra je zvyčajne v rozsahu 0 až 0.5, napr. 0; 0.001; 0.01; 0.1 alebo 0.5. Štandardne 
nastavená hodnota je 0.1.

V prípade metódy Tension sa uplatňuje pravidlo, čím vyššia je váha, tým je štruk-••
túra výslednej interpolácie kontrastnejšia. Zároveň výsledok nepresahuje rozsah 
intervalu vstupných hodnôt. Hodnota parametra je zvyčajne v rozsahu 0 až 10, 
napr. 0, 3, 5 alebo 10.

Number of points (optional) •• – počet bodov, ktoré vstupujú do interpolačného vý-
počtu. S počtom bodov rastie aj zasiahnutý rozsah interpolovaného priestoru, t. j. 
zväčší sa vplyv vzdialenejších bodov a výsledná štruktúra môže byť hladšia. 

2.5.3. Trend
Interpoláciu povrchu pomocou algoritmu Trend môžeme vykonať prostredníctvom 

položky Trend aplikácie ArcToolbox (Spatial Analyst Tools → Interpolation → Trend). 
V zobrazenom okne je k dispozícii niekoľko možností nastavenia parametrov (obrázok 15): 

Input point features••  – vrstva vstupných bodov (známa reprezentácia priestoru), kto-
rá obsahuje atribút s nadmorskou výškou.
Z value field••  – výber atribútu s obsahom hodnôt nadmorských výšok.

Output raster••  – výsledná interpolácia povrchu v rastrovom dátovom formáte.

Output cell size (optional)••  – veľkosť bunky výsledného rastra.

Polynomial order (optional)••  – vyjadrenie stupňa polynómu, kde lineárny je rovi-

Obrázok 14
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na, kvadratický je plocha s jedným 
ohybom, plocha s dvomi ohybmi je 
kubický polynóm atď. Čím je číslo 
menšie, tým viac je interpolovaný 
priestor bližší rovine. Stupeň sa 
zadáva ako celé číslo v rozsahu od 
1 do 12. Štandardne je nastavená 
hodnota 1.

Type of regression (optional) •• – 
k dispozícii sú dva druhy regresie, 
resp. priebehu závislosti medzi zná-
mymi a neznámymi hodnotami: 

regresia •• LINEAR je aplikácia 
vhodná pre spojité dáta,

regresia •• LOGISTIC sa používa na odhad pravdepodobnosti výskytu určitého javu, 
kde vstupné hodnoty sú na úrovni záznamu 0 alebo 1 (napr. výskyt druhov rastlinstva 
alebo živočíšstva, t. j. áno/nie). Vstupné dáta majú diskrétny charakter. Výstupom je 
spojitý dátový typ s hodnotami pravdepodobnosti výskytu v intervale od 0 do 1.

Output RMS file (optional) •• – v definovanom priestore vytvoríme súbor, v ktorom 
bude uložená stredná kvadratická odchýlka (RMS), t. j. porovnávanie vstupných 
a výstupných hodnôt. RMS slúži na správnu voľbu stupňa polynómu. Vhodnosť hod-
noty polynómu je vyjadrená menším výsledným číslom RMS. 

2.5.4. Kriging
Interpoláciu povrchu pomocou algo-

ritmu Kriging môžeme vykonať položkou 
Kriging aplikácie ArcToolbox (Spatial 
Analyst Tools → Interpolation → Kri-
ging). V zobrazenom okne je k dispozícii 
niekoľko možností nastavenia parametrov 
(obrázok 16): 

Input point features••  – vrstva vstup-
ných bodov (známa reprezentácia 
priestoru), ktorá obsahuje atribút 
s nadmorskou výškou.

Z  value field••  – výber atribútu 
s  obsahom hodnôt nadmorských 
výšok.

Output raster••  – výsledná interpo-
lácia povrchu v  rastrovom dáto-
vom formáte.

•• Kriging method – výber konkrét-
nej metódy, ktorou špecifikujeme 

Obrázok 15

Obrázok 16
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parametre semivariogramov. K  dispozí-
cii máme metódu Ordinary a  Universal. 
Ordinary kriging predpokladá neznámu 
strednú hodnotu v  celej oblasti. Univer-
sal kriging vypracuje lokálne premenný 
trend rovnakého typu v  celej oblasti. Pri 
každej metóde je potrebné vybrať autoko-
relačný algoritmus. Priestorovú autokore-
láciu interpolovaného povrchu, resp. javu, 
vzhľadom na vzdialenosť a  smer pôsobe-
nia vyjadruje konkrétny semivariogram. 
K dispozícii je niekoľko typov, ktoré zároveň môžeme upraviť o podrobnejšie nastave-
nie (Advanced Parameters) znázornené na obrázku 17. 
Output cell size (optional)••  – veľkosť bunky výsledného rastra.
Search radius (optional)••  – nastavenie priestorového polomeru, ktorý obmedzuje 
počet vstupných bodov interpolovaného priestoru. Ide o rovnaké nastavenia, ako pri 
položke IDW.
Output variance of prediction raster (optional) •• – osobitný raster, v ktorom každá 
bunka obsahuje predpokladanú hodnotu semivariogramu.

2.5.5. Natural Neighbor
Interpoláciu povrchu pomocou algoritmu Natural Neighbor môžeme vykonať položkou 

Natural Neighbor aplikácie ArcToolbox (Spatial Analyst Tools → Interpolation → Natural 
Neighbor). V zobrazenom okne je k dispozícii niekoľko možností nastavenia parametrov 
(obrázok 18):

Input point features••  – vrstva vstup-
ných bodov (známa reprezentácia 
priestoru), ktorá obsahuje atribút 
s nadmorskou výškou,
Z  value field••  – výber atribútu 
s  obsahom hodnôt nadmorských 
výšok,
Output raster••  – výsledná interpo-
lácia povrchu v  rastrovom dáto-
vom formáte,
Output cell size (optional)••  – veľ
kosť bunky výsledného rastra.

2.5.6. Topo to Raster
Interpoláciu povrchu pomocou metódy Topo to Raster môžeme vykonať položkou 

Topo to Raster aplikácie ArcToolbox (Spatial Analyst Tools → Interpolation → Topo to 
Raster). V zobrazenom okne je k dispozícii niekoľko možností nastavenia parametrov (ob-
rázok 19):

Obrázok 17

Obrázok 18
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Input feature data •• – vstupná vrstva 
vektorových geografických informácií 
v nasledujúcom rozsahu:

PointElevation••  – homogénne 
alebo nehomogénne bodové pole 
(nadmorských výšok) vo forme 
vektorovej reprezentácie. V  časti 
Field vyberáme atribút určujúci 
vstupné hodnoty do interpolácie – 
hodnoty nadmorských výšok.

Contour •• – líniová reprezentácia 
nadmorskej výšky v  podobe vrs-
tevníc. Do časti Field vyberáme 
atribút nadmorskej výšky.

Stream •• – líniová reprezentácia 
vodných tokov, ktoré zabezpeču-
jú hydrologicky relevantný DMR, 
tzv. „prietočný DMR“. Dôležitá je 
pri tomto type vektorovej vrstvy 
orientácia vektora – tzn. nutnosť 
orientácie línií v smere zhora na-
dol (v prípade opačnej orientácie vektora je vygenerované neprirodzené zareza-
nie vodného toku). Pri interpolácii povrchu majú vodné toky prioritu pred hod-
notami výškovej základne z PointElevation alebo Contour. Pre vodné toky nie je 
možné vybrať konkrétny atribút.

•• Sink – bodová reprezentácia topografického poklesu, resp. terénnych depresií. 
Identifikované depresie sa stanú nadradenými voči výškovej základni. Pomocou 
reprezentácie sa explicitne počíta s dopredu zadefinovanými depresiami a nevy-
lučujú sa z  výpočtu. Do časti Field zadávame atribút nadmorskej výšky, ktorá 
je priradená k jednotlivým depresiám. Bez priradeného atribútu bude do úvahy 
braná len geografická poloha terénnych depresií.

Boundary •• – polygónová reprezentácia, za hranicami ktorej budú výstupnému 
rastru priradené hodnoty „NoData“. Tejto dátovej reprezentácii nie je možné vy-
brať konkrétny atribút.

Lake •• – polygónová reprezentácia v podobe vodných plôch, ktoré budú obsahovať 
hodnoty minimálnych výšok z pobrežnej čiary. Pre túto dátovú reprezentáciu nie 
je možné vybrať konkrétny atribút.

Cliff •• – líniová reprezentácia v podobe útesov. Smer útesu musí byť orientovaný 
tak, že ľavá strana orientovanej línie predstavuje nižšie výškové hodnoty útesu 
a pravá strana vyššie výškové hodnoty útesu. Tejto dátovej reprezentácii nie je 
možné vybrať konkrétny atribút.

Exclusion••  – polygónová reprezentácia časti povrchu, ktorá bude vylúčená z pro-
cesu interpolácie, napr. koruny hrádzí, priehrad alebo mosty. Pre túto dátovú 
reprezentáciu nie je možné vybrať konkrétny atribút.

Obrázok 19
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Coast••  – polygónová reprezentácia pobrežia. Bunky vo výslednom rastri, ktoré le-
žia mimo týchto plôch, budú obsahovať menšie hodnoty, ako používateľom špe-
cifikovaný minimálny výškový limit. Pre túto dátovú reprezentáciu nie je možné 
vybrať konkrétny atribút.

Output surface raster••  – výsledná interpolácia povrchu v rastrovom dátovom formáte.

Output cell size (optional)••  – veľkosť bunky výsledného rastra.

Output extent (optional) •• – rozsah výstupného rastra, ktorý môžeme definovať po-
mocou minimálnych a maximálnych X, Y súradníc alebo pomocou zvolenej vrstvy.

Margin in cell (optional) •• – špecifikácia vonkajšieho lemu, t. j. vzdialenosť od hranice 
interpolovaného priestoru, ktorá je vyjadrená počtom buniek. Interpolácia povrchu 
bude prebiehať aj v definovanom leme, a to tak, aby bolo možné vytvoriť napojenie 
na prípadný susedný raster. Parametrom sa môže stať len hodnota rovná alebo väčšia 
ako „0“, pričom zhoda dosiahnutá pri napojení susedných rastrov je tým väčšia, čím 
väčšia je hodnota nastaveného parametra.

Smallest z value to be used in interpolation (optional) •• – minimálna výšková hod-
nota, ktorá bude použitá v interpolačnom procese. Štandardne je nastavená hodnota 
20 % z najmenšej vstupnej hodnoty.

Largest z value to be used in interpolation (optional) •• – maximálna výšková hodno-
ta, ktorá bude použitá v  interpolačnom procese. Štandardne je nastavená hodnota 
20 % z najväčšej vstupnej hodnoty.

Drainage enforcement •• – zdôraznenie odtokovej siete pomocou voľby:

ENFORCE••  – vyplnenie všetkých depresií, t. j. používateľom definovaných (pravé 
depresie), aj ostatných, tzn. bez ďalšej špecifikácie (nepravé depresie). Uvedenou 
voľbou vytvoríme odtokovo korektný model.

NO_ENFORCE••  – ani jedna depresia nebude vyplnená.

ENFORCE_WITH_SINK••  – body vstupnej vrstvy Sink budú zachované (pravé 
depresie), ostatné topografické poklesy budú vyplnené (nepravé depresie).

Primary type of input data (optional) •• – optimalizácia vyhľadávacích metód, podľa 
ktorých sa uskutočňuje generalizácia vrcholov a údolí. Vyberáme prevládajúcu výš-
kovú reprezentáciu na vstupe, ktorá je dominantná, t. j. CONTOUR (vrstevnice) ale-
bo SPOT (body-kóty).

Maximum number of iterations (optional)••  – počet interpolačných iterácií (opakova-
ní), ktoré majú vplyv na bezodtokové oblasti. Počet iterácií musí byť väčší než nula, 
preddefinovaná hodnota je 40. Táto hodnota je adekvátna pre oba typy vstupných 
dát, pre línie, ako aj pre body. Hodnota 30 zabezpečí vyplnenie plytších zníženín. 
Naopak, hodnota väčšia ako 40 vyplní viac zníženín a zvýrazní hrebene a vytvorené 
korytá tokov.

Roughness penalty (optional) •• – integrál štvorca derivácie druhého rádu ako miera 
hrubosti (drsnosti). Táto hodnota je preddefinovaná pri líniových vstupných dátach 
ako 0, pri bodových vstupných dátach sa neodporúča prekročiť hodnotu 0,5.

Profile curvature roughness penalty (optional) •• – lokálne vyrovnávanie nerovností, 
ktoré čiastočne nahrádza celkové nerovnosti. 
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Discretisation error factor (optional) •• – regulácia hladkosti prevodu vstupných dát 
na raster. Hodnota musí byť väčšia než 0. Bežne sa používa hodnota v rozsahu od 0,2 
do 2. Štandardná hodnota je 1. Čím je vyššia hodnota parametra, tým je väčšia miera 
vyhladenia interpolovaného povrchu.

Vertical standard error (optional) •• – náhodné chyby vo výškových hodnotách vstup-
ných dát. Hodnota musí byť nulová alebo vyššia. Štandardne je nastavená na 0, keď-
že vstupné dáta by nemali vykazovať žiadne výškové chyby. Vertikálna štandardná 
odchýlka môže byť nastavená na malú kladnú hodnotu vtedy, ak vstupné dáta majú 
výraznú náhodnú vertikálnu odchýlku s rovnomerným rozptylom. 

Tolerance 1 (optional) •• – vyjadrenie hustoty výškových dát vo vzťahu k odtokovej 
sieti, resp. k vodným tokom. Hodnota sa preberá z položky Vertical standard error. 
V prípade vrstevníc sa odporúča použiť polovičnú hodnotu priemerného výškové-
ho intervalu. Pre bodovú vstupnú vrstvu sa tolerancia nastaví ako štandardná chyba 
hodnoty Z súradnice. Líniové vstupné dáta používajú polovičnú hodnotu priemerné-
ho intervalu hodnoty z línií. Preddefinovaná hodnota dominantného typu vstupných 
dát CONTOUR je 2,5 a pre typ SPOT sa rovná 0.

Tolerance 2 (optional) •• – zamedzenie vypĺňania depresných plôch nereálne vysokými 
bariérami. Parameter musí vyť väčší ako 0. Preddefinovaná hodnota pre dominantný 
typ vstupných dát CONTOUR je 100, pre typ SPOT sa táto hodnota rovná 200.

Optional outputs••  – ponuka tvorby samostatných výstupných vrstiev a textových sú-
borov, ktoré nás informujú o  priebehu interpolačného procesu. Zároveň môžeme 
prostredníctvom vrstiev identifikovať interpolačné chyby. Ide hlavne o tvorbu napr. 
výstupnej vrstvy vodných tokov (Output stream polyline feature), výstupnej bodovej 
reprezentácie neodstránených depresií (Output remaining sink point feature), dia-
gnostických textových súborov s informáciou o všetkých vstupných vrstvách a para-
metroch s počtom odstránených depresií (Output diagnostic file) atď. 

Interpoláciu povrchu, resp. tvorbu DTM, môžeme uskutočniť aj pomocou rozšírenia 
Geostatistical Analyst. Toto samostatné rozšírenie aplikácie ArcMap ponúka obsiahlejšie 
možnosti definovania vstupných parametrov. Zároveň je k dispozícii aj grafický náhľad zvo-
lených hodnôt vybraných parametrov, ktoré budú aplikované v procese výslednej interpo-
lácie.

Otázky:

Čo sa chápe pod pojmom reliéf?1.	

Aký je rozdiel medzi digitálnym výškovým modelom  2.	
a digitálnym modelom reliéfu?

Aký je rozdiel medzi digitálnym modelom terénu a reliéfu?3.	

Do akých dátových modelov sa abstrahujú informácie o reliéfe?4.	

Čo je to interpolácia?5.	

Aké interpolačné algoritmy resp. metódy sú k dispozícii  6.	
v prostredí aplikácie ArcMap?
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3. Analýza reliéfu
Kapitola s  názvom „Analýza reliéfu“ je zameraná na základné analýzy a  interpretácie 

vlastností zemského povrchu v prostredí ArcGIS (ArcMap). Na tento účel budeme vnímať 
zemský povrch ako priestorovo rozložený a spojitý dátový fenomén – reliéf. 

3.1. Morfometrická analýza reliéfu
Morfometrická analýza podľa Smolovej a Kirchnera (2010) umožňuje kvantitatívne opí-

sať územie s  jeho čiastkovými terénnymi atribútmi. Medzi hlavné úlohy morfometrickej 
analýzy patrí delimitácia tzv. morfoštruktúrnych jednotiek napr. na účely kartografie, geo-
morfológie, ďalej slúži na identifikáciu genézy, veku a typu morfoštruktúr, vplyvov tektoniky 
atď. (Krcho, 1990). Morfometrická analýza reliéfu vychádza z účelovej analýzy priestorovej 
distribúcie nadmorských výšok. V našom prípade ide o analýzu distribúcie nadmorských 
výšok pomocou digitálneho modelu terénu (DTM). 

Výsledkom morfometrickej analýzy reliéfu sú parametre a charakteristiky, ktoré v zmys-
le Miklósa a Izakovičovej (1997), Miklósa et al., (1997) smerujú k interpretácii vzťahu medzi 
reliéfom a jeho dynamikou, napr. pohyb vody a materiálu po povrchu. Uvedení autori záro-
veň začleňujú výsledky morfometrickej analýzy reliéfu do nasledovných skupín:

Topické (vertikálne) parametre reliéfu1.	  – určujú sa zo vzájomného vzťahu vertikál-
nej hodnoty – nadmorskej výšky elementárnej plôšky (polohy resp. bodu) a sused-
ných bodov reliéfu. Vyčlenením jednotlivých hodnôt ukazovateľov v priestore dostá-
vame ich homogénne areály – topy. Ide o najpoužívanejšie morfometrické parametre 
reliéfu, preto sa im budeme venovať podrobnejšie. Do tejto skupiny patrí:

Absolútna výška terénu••  je výška (absolútna odľahlosť) bodu zemského povr-
chu nad strednou úrovňou hladiny konkrétneho mora (Jadranský, Baltský ho-
rizont...). 

•• Relatívna výška terénu je rozdiel nadmorských výšok (absolútnych odľahlostí) 
dvoch bodov reliéfu, resp. prevýšenie vo vzťahu k vopred určenej základnej nad-
morskej výške (horizontu).

•• Sklon reliéfu v smere spádových kriviek. V praktickom používaní ukazovateľa sa 
spravidla konštruujú izoklíny (izolínie spájajúce miesta s rovnakým uhlom sklo-
nu), ktoré potom ohraničujú areály s daným intervalom sklonu. 

•• Orientácia reliéfu voči svetovým stranám je stabilná expozícia reliéfu voči chodu 
Slnka.

•• Horizontálna krivosť reliéfu je rozhodujúcim ukazovateľom na určenie smerov 
odtoku a integrácie vody i materiálu po svahoch. Určuje sa zo zakrivenia vrstev-
níc (Krcho, 1973) a vymedzujú sa ňou konvexné (chrbty, rázsochy), konkávne 
(doliny, úvaliny, brázdy), prípadne nezakrivené plochy. 

•• Normálová krivosť reliéfu je rozhodujúca na určenie tendencie pohybu vody 
a materiálu po svahu (zrýchľovanie, spomaľovanie). Predstavuje zakrivenie spá-
dových kriviek vo vertikálnom smere.

Formy reliéfu••  sú priestorovou syntézou horizontálnej a  normálovej krivosti. 
Kombináciou konvexných, konkávnych a nezakrivených tvarov z oboch druhov 
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krivostí vzniká 9 možných základných tvarov, ktorými sa dá určiť komplexný tvar 
každej plochy (Krcho, 1973).

Chorické (horizontálne) parametre reliéfu2.	  – určujú sa zo vzťahu gravitácie a smeru 
spádových kriviek. Hlavným smerom interpretácie tohto ukazovateľa je stanovenie 
smeru, spôsobu pohybu a integrácie (dezintegrácie) odtoku vody a zároveň aj pohy-
bu materiálu po svahu. Podstatou je vytvorenie tzv. mikropovodí, ktoré sa na základe 
ich charakteru môžu považovať za elementárne morfochóry. Do tejto skupiny za-
raďujeme napr. konštrukciu spádových kriviek, veľkosť elementárnych gravitačných 
areálov, hranice rovnakého smeru a pôsobenia gravitácie.

Topicko-chorické (vertikálno-horizontálne) ukazovatele reliéfu3.	  – vytvárajú sa na 
základe kombinácie topických a chorických ukazovateľov. Tieto ukazovatele nie je 
správne považovať za veľkostné prechody medzi topickou a chorickou úrovňou, ale 
medzi ich funkčnou kombináciou. Do tejto skupiny zaraďujeme napr. určenie polohy 
na reliéfe.

Morfometrickú analýzu reliéfu môžeme v  prostredí aplikácie ArcMap uskutočniť 
prostredníctvom rozšírení Spatial Analyst a 3D Analyst. 

Primárnym dátovým vstupom morfometrických analýz reliéfu je dostatočne presný di-
gitálny model terénu (DTM). Hodnoty nadmorských výšok sú abstrahované do spojitých 
dátových modelov, ktorými môžu byť TIN alebo raster. V prípade TIN modelov sa používa 
v prostredí ArcMap rozšírenie 3D Analyst. Na analýzu digitálneho modelu terénu na báze 
rastrových modelov používame rozšírenie Spatial Analyst.

3.1.1. Orientácie reliéfu 
Odvodenie orientácií reliéfu voči svetovým stranám vykonáme položkou Aspect apliká-

cie ArcToolbox (Spatial Analyst Tools → Surface → Aspect). V zobrazenom dialógovom 
okne máme k dispozícii nasledovné možnosti (obrázok 20):

Input raster••  – digitálny model terénu, v ktorom sa nachádza priebeh výškovej repre-
zentácie reliéfu,

Output raster •• – výsledná rastrová reprezentácia, v ktorej sa budú nachádzať odvo-
dené orientácie reliéfu voči svetovým stranám v rozsahu 0° – 360°, kde sever je 0°, 
východ je 90°, juh je 180° a západ je 270°. Rovina (0°) je reprezentovaná hodnotou 
-1. Každej bunke je priradená jedna hodnota z vyššie uvedeného rozsahu, t. j. od 0° 
do 360°. 

Nástroj Aspect automaticky vytvorí 
symbologickú interpretáciu (Layer Pro-
perties) orientácií rovnakých areálov re-
liéfu voči svetovým stranám (obrázok 21). 
Ide však len o symbologickú interpretáciu, 
ktorú je potrebné transformovať na trvalé 
areály, t. j. na novú vrstvu s reklasifikova-
nými hodnotami, napr. združené kategó-
rie orientácií ôsmich základných smerov. 

Obrázok 20
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Transformáciu môžeme vykonať nástrojom Reclassify (Spatial Analyst Tools → Reclass → 
Reclassify) pomocou hodnôt, ktoré sú uvedené v tabuľke 1. 

Obrázok 21

Tabuľka 1  Reklasifikácia hodnôt orientácií reliéfu

Code Smer orientácie Uhlový interval

-1 Flat rovina No Slope

1 North sever 0° – 22.5°

2 Northeast severovýchod 22.5° – 45°

3 East východ 45° – 135°

4 Southeast juhovýchod 135° – 180°

5 South juh 180° – 225°

6 Southwest juhozápad 225° – 270°

7 West západ 270° – 315°

8 Northwest severozápad 315° – 337.5°

9 North sever 337.5° – 360°

3.1.2. Sklon reliéfu 
Odvodenie sklonov reliéfu vytvoríme položkou Slope aplikácie ArcToolbox (Spatial 

Analyst Tools → Surface → Slope). V  zobrazenom dialógovom okne máme k  dispozícii 
nasledovné možnosti (obrázok 22):
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Input raster••  – digitálny model te-
rénu, v  ktorom sa nachádza prie-
beh výškovej reprezentácie reliéfu,

Output raster •• – výsledná rastro-
vá reprezentácia, v  ktorej sa budú 
nachádzať odvodené sklony ako 
maximálna miera zmeny medzi 
bunkami,

Output measurement (optional)••  
– voľba tzv. mernej jednotky, a  to 
buď stupňov (DEGREE) alebo per-
cent (PERCENT_RISE),

Z  factor (optional) •• – násobok vstupnej výškovej reprezentácie reliéfu, t. j. číselné 
hodnoty priradené k DTM môžeme násobiť nami zadanou hodnotou.

Výsledný raster bude obsahovať bunky s priradeným sklonom (obrázok 23). Následne 
odporúčame pomocou procesu reklasifikácie (Spatial Analyst Tools → Reclass → Reclas-
sify) zlúčiť bunky do areálov v intervalovom rozmedzí 0° – 30’, 30’ – 1°, 1° – 3°, 3° – 7°, 7° 
– 12°, 12° – 17°, 17° – 25° a viac, prípadne do inak definovaných areálov.

Obrázok 23

Obrázok 22
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3.1.3. Krivosti reliéfu
Odvodenie horizontálnej a  normálovej (verti-

kálnej) krivosti reliéfu vykonáme položkou Curva-
ture aplikácie ArcToolbox (Spatial Analyst Tools 
→ Surface → Curvature). V zobrazenom dialógo-
vom okne máme k dispozícii nasledovné možnosti 
(obrázok 24): 

Input raster••  – digitálny model terénu, 
v ktorom sa nachádza priebeh výškovej re-
prezentácie reliéfu,

Output raster •• – výsledná rastrová reprezen-
tácia, v ktorej sa budú nachádzať odvodené 
krivosti reliéfu, t. j. kombinácia vertikálnej 
a horizontálnej krivosti (obrázok 25),

Z factor (optional) •• – násobok vstupnej výško-
vej reprezentácie reliéfu, t. j. číselné hodnoty 
priradené k DTM môžeme násobiť nami za-
danou hodnotou. Ak sú vstupné hodnoty x, 
y a z súradníc v rovnakých jednotkách [napr. 
v m], tak Z-factor je rovný 1,

Output profile curve raster (optional)••  – vý-
sledná vertikálna krivosť reliéfu (obrázok 
26),

Output plan curve raster (optional)••  – vý-
sledná horizontálna krivosť reliéfu (obrá-
zok 27).

Odvodené vertikálne a  horizontálne krivosti 
reliéfu obsahujú hodnoty v rozpätí od -999 do 999, 
ktoré je potrebné transformovať do samostatných 
areálov v intervaloch:

Vertikálna krivosť 1.	 znázornená na obrázku 
28:

A••  – plochy konkávne (od -999 do -0,1),

0••  – plochy rovné (od -0,1 do 0),

X••  – plochy konvexné (od 0 do 999).

Horizontálna krivosť 2.	 znázornená na ob-
rázku 29: 

A••  – plochy konkávne (od -999 do -0,1),

0••  – plochy rovné (od -0,1 do 0),

X••  – plochy konvexné (od 0 do 999).

Obrázok 24

Obrázok 25

Obrázok 26

Obrázok 27

Obrázok 28

Obrázok 29
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3.2. Analýza vzdialeností a viditeľností
Analýza vzdialeností a viditeľností vychádza z geografickej distribúcie nadmorskej výš-

ky abstrahovanej do podoby DTM. Analýza povrchu umožňuje študovať plynulú zmenu 
nadmorskej výšky. Na základe tejto zmeny vieme určiť najkratšiu vzdialenosť potrebnú na 
presun materiálu, optimálne umiestnenie objektov vzhľadom k reliéfu alebo viditeľnosť vo-
pred určeného bodu. Tento typ analýz umožňuje spojitý charakter dátových modelov, ktoré 
vykazujú priestorovú zmenu hodnôt.

3.2.1 Najmenej nákladná trasa
Výpočet alebo stanovenie najmenej nákladnej trasy je založené na meraní vzdialeností 

pomocou nákladového povrchu. Nákladový povrch predstavuje rastrovú vrstvu, ktorá de-
finuje odpor, trenie alebo náklady (náročnosť) pohybu v  rovine cez bunku. Najčastejším 
faktorom odporu je napr. sklon reliéfu alebo krajinná pokrývka. Čím je vyššia hodnota bun-
ky, tým je vyjadrený väčší odpor. Hodnoty môžu byť celé aj desatinné čísla, avšak nesmú 
obsahovať záporné hodnoty. 

Výpočet najmenej nákladnej trasy určitým povrchom vypočítame pomocou funkcie 
váženej vzdialenosti. Ide o  výpočet povrchu (nákladový povrch), ktorý obsahuje hodno-
ty minimálnych cestovných nákladov z každej bunky do zdrojovej bunky, a to na základe 
vzdialenosti a odporu. V takomto ponímaní sa vzdialenosť meria v jednotkách nákladov, nie 
v geografických alebo dĺžkových jednotkách. Výpočet sa realizuje nasledovným spôsobom:

Definujeme dve samostatné vrstvy, prvou je zdrojová vrstva a  druhou je cieľová 1.	
vrstva. V  obidvoch vrstvách sa nachádza vektorová reprezentácia bodu, prípadne 
viacerých bodov zdroja a cieľa.

Definujeme nákladový povrch ako rastrovú vrstvu odporu pohybu cez ňu. Premenné 2.	
vstupy sú mierou náročnosti, ktorú určujeme z pohľadu času, finančných prostried-
kov, spotreby energií atď. Najpoužívanejším nákladovým povrchom sú napr. sklony 
reliéfu, kde väčšia hodnota sklonu predstavuje väčší odpor pohybu.

Vytvoríme vrstvu akumulovaných cestovných nákladov nástrojom 3.	 Cost Distance 
(Spatial Analyst Tools → Distance → Cost Distance). Nástroj akumuluje cestov-
né náklady s rastúcou vzdialenosťou od zdroja (zdrojov). Počas procesu dochádza 
k štatistickému váženiu hodnôt jednotlivých buniek, t. j. hodnoty sú spriemerova-
né a  násobené veľkosťou buniek 
alebo vzdialenosťou medzi stredmi 
buniek. K  dispozícii je nasledovný 
rozsah voľby parametrov (obrázok 
30):

Input raster or feature source ••
data – vektorová alebo rastrová 
vrstva, v ktorej je abstrahovaný 
zdroj alebo zdroje. 

Input cost raster •• – nákladový 
povrch, ktorý môže mať ana-
lytický i  syntetický charakter. 

Obrázok 30
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V prípade sklonov ide o analytické odvodenie zmeny priebehu nadmorskej výš-
ky.

Output distance raster •• – výsledná rastrová reprezentácia akumulovaných cestov-
ných nákladov (obrázok 31). Vytvorený raster nepredstavuje líniovú vzdialenosť, 
ale sumu minimálnych cestovných nákladov, ktorá sa akumuluje prechodom po 
najmenej nákladnej ceste medzi zdrojovou bunkou a ostatnými bunkami.

Obrázok 31

Maximum distance (optional) •• – maximálna vzdialenosť resp. prah, ktorý hodno-
ty akumulovaných nákladov nesmú prekročiť. Bunkám, ktoré prekročia zadanú 
vzdialenosť, sa pridelí hodnota No Data. Maximálna vzdialenosť je daná rozsa-
hom nákladového povrchu.

Output backlink raster (optional) –••  vytvorenie spätnej väzby, resp. smerového 
prepojenia každej bunky s jej najbližšou zdrojovou bunkou (obrázok 32). Každej 
bunke je priradená hodnota, ktorá označuje najkratšiu cestu späť k zdroju. Hod-
noty v rozsahu od 1 do 8 a 0 majú len zdrojové bunky. Smerová vrstva používa 
nástroj Cost Path.

Určíme najmenej nákladnú trasu nástrojom 4.	 Cost Path (Spatial Analyst Tools → Dis-
tance → Cost Path). Výsledkom bude líniové prepojenie jednotlivých buniek s naj-
menšími akumulovanými cestovnými nákladmi medzi zdrojom a cieľom (obrázok 
33). K dispozícii je nasledovný rozsah voľby parametrov:

Input raster or feature destination data••  – vektorová alebo rastrová vrstva, v kto-
rej je abstrahovaný cieľ alebo ciele; 

Destination field (optional) •• – atribútové pole, z  ktorého sa získavajú hodnoty 
cieľových miest;
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Input cost distance raster••  – povrch akumulovaných cestovných nákladov. Ide 
o nákladový povrch, t. j. výsledná rastrová reprezentácia z nástroja Cost Distan-
ce;

Input cost backlink raster •• – spätná väzba, resp. smerové prepojenie buniek, ako 
výsledná reprezentácia nástroja Cost Distance;

Output raster •• – výsledná rastrová reprezentácia v podobe líniového útvaru s naj-
menej nákladnou trasou medzi zdrojom a cieľom (obrázok 34); 

Path type (optional)••  – typ výpočtu stanovenia najmenej nákladnej trasy v nasle-
dovnom rozsahu:

EACH_CELL••  – výpočty pre každú bunku tak, aby sa vytvorili samostatné ces-
ty ku každej cieľovej bunke,

Obrázok 32

Obrázok 33
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EACH_ZONE••  – výpočty pre každú zónu tak, aby sa vytvorili samostatné cesty 
v rozpätí agregovaných cieľových zón,

BEST_SINGLE••  – výpočty pre každú bunku s dôrazom len na najmenšie hod-
noty akumulovaných cestovných nákladov tak, aby sa vytvorila len jedna naj-
menej nákladná cesta. 

Obrázok 34

3.2.2. Lokalizácia najvhodnejších miest
Optimálne najvhodnejšie umiestnenie objektov vzhľadom k reliéfu je možné realizovať 

len pomocou rastrových dátových modelov. Najpoužívanejším príkladom tohto typu úloh je 
lokalizácia miesta vhodného na výstavbu fotovoltaickej elektrárne. Na lokalizáciu elektrárne 
sú nasledovné vstupné požiadavky:

orientácia od juhovýchodu po juhozápad, t. j. od 135° do 270°,1.	

umiestnenie by malo byť v areáli so sklonom reliéfu od 10° do 40°,2.	

umiestenie vo vzdialenosti k distribučnej sieti do 200 m.3.	

Podľa vstupnej špecifikácie môžeme pristúpiť k lokalizácii najvhodnejšieho miesta po-
mocou nasledovných krokov, ktoré tvoria určitý metodický prístup:

Odvodenie vrstvy sklonu reliéfu z DTM. Výsledný raster s priradenými sklonmi je 1.	
potrebné reklasifikovať do dvoch kategórií areálov. Do prvej s rozpätím hodnôt od 
10° do 40° sklonu a  druhej, kde zvyšným areálom priradíme hodnotu „NoData“. 
Operáciou získame vrstvu s plochou, ktorá bude mať hodnotu 1, t. j. areál sklonu od 
10° do 40°.
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Odvodenie vrstvy orientácií reliéfu voči svetovým stranám z DTM. Výsledný raster 2.	
s priradenými orientáciami reliéfu je potrebné reklasifikovať do dvoch areálov, jedné-
ho s rozpätím hodnôt orientácií od 135° do 270° a druhého s hodnotami mimo tohto 
rozpätia, ktorému priradíme hodnotu „NoData“. Operáciou získame vrstvu s plo-
chou, ktorá bude mať hodnotu 1, t. j. areály majúce orientácie od 135° do 270°.

Meranie vzdialeností k  distribučnej sieti vykonáme položkou 3.	 Euclidean Distance 
aplikácie ArcToolbox (Spatial Analyst Tools → Distance → Euclidean Distance). 
Výsledný raster s priradenými hodnotami vzdialeností od distribučnej siete (obrázok 
35) bude potrebné reklasifikovať opäť do dvoch areálov, jedného s pôvodnými hod-
notami v rozpätí od 0 m do 200 m a druhého s hodnotami vzdialeností mimo tohto 
rozpätia, ktorým priradíme hodnotu „NoData“. Operáciou získame vrstvu s plochou, 
ktorá bude mať hodnotu 1, t. j. areál so vzdialenosťami od 0 m do 200 m. 

Obrázok 35

Plochy, ktoré sme identifikovali vo vrstve sklonov, orientácií a vzdialeností, obsahu-4.	
jú binárne hodnoty, kde hodnota 1 predstavuje nami požadovaný atribút. Pomocou 
mapovej algebry a tzv. booleovskej logiky (operátor „and“ alebo „&”) skombinujeme 
všetky vrstvy do jednej výslednej vrstvy. Vzájomnú kombináciu uskutočníme pomo-
cou položky Raster Calculator (obrázok 36) aplikácie ArcToolbox (Spatial Analyst 
Tools → Map Algebra → Raster Calculator). Výsledok optimálne najvhodnejšieho 
umiestnenia je znázornený na obrázku 37.
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Obrázok 36

Obrázok 37

3.2.3. Analýza viditeľnosti
Analýzou viditeľnosti identifikujeme bunky rastra DTM, ktoré sú viditeľné z definované-

ho miesta. Bunky, ktoré sú z definovaného miesta viditeľné, získavajú hodnotu „1“ a tie, ktoré 
nie je vidieť, dostanú hodnotu „0“, teda „NoData“. Analýzu viditeľnosti vykonáme položkou 
Viewshed aplikácie ArcToolbox (Spatial Analyst Tools → Surface → Viewshed). V zobraze-
nom dialógovom okne máme k dispozícii nasledovné možnosti (obrázok 38):

Input raster••  – digitálny model terénu, v ktorom sa nachádza priebeh výškovej repre-
zentácie reliéfu;
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Input point or polyline observer feature •• – pozorovací bod, resp. definované miesto 
pomocou vektorovej vrstvy s obsahom bodových alebo líniových prvkov; 
Output raster •• – výsledná rastrová reprezentácia, v ktorej sa budú nachádzať odvode-
né areály viditeľnosti, t. j. plochy s hodnotou 1 (obrázok 39); 
Z  factor (optional) •• – násobok vstupnej výškovej reprezentácie reliéfu, t. j. číselné 
hodnoty priradené k DTM môžeme násobiť nami zadanou hodnotou;
Use earth curvature corrections (optional)••  – možná aplikácia faktora zakrivenia 
zemského povrchu. Využíva sa hlavne pre rozľahlejšie územia, kde je nutné rátať aj 
s týmto faktorom;
Refractivity coefficient (optional) •• – voľba koeficientu lomu viditeľného svetla vo 
vzduchu. 

Obrázok 39

Obrázok 38



34

3.3. Znázornenie reliéfu
Znázornenie reliéfu má osobitné postavenie v oblasti digitálnej kartografie. Správne zo-

brazenie reliéfu je vždy podmienené výberom správnej metódy, ktorá sa odlišuje podľa štýlu 
a účelu. Robinson et al. (1995) rozlišuje nasledovné metódy znázornenia reliéfu:

perspektívne obrázkové mapy – blogdiagramy, šikmé regionálne pohľady atď.,••

morfometrické mapy – sklony, orientácie, krivosti atď.,••

mapy geomorfologických jednotiek – sústavy, oblasti, celky atď.,••

šrafy – krátke líniové symboly v smere najväčšieho sklonu,••

vrstevnice – najčastejšie používaná metóda znázornenia povrchu,••

tieňovanie – generované z DTM.••

3.3.1. Tieňovanie reliéfu
Na tieňovanie reliéfu máme v prostredí ArcMap k dispozícii nástroj Hillshade (Spatial 

Analyst Tools → Surface → Hillshade). Nástroj vychádza z analytického tieňovania, t. j. hy-
potetického osvetlenia povrchu pomocou osvetlenia z konkrétnej výšky a s konkrétnym azi-
mutom. Takéto tieňovanie môže byť vytvorené na účely geografických analýz (napr. stano-
venie doby a intenzity slnečného žiarenia) alebo pre potreby grafickej vizualizácie povrchu. 
V tematických mapách malých mierok predstavuje tieňovanie reliéfu často jediný spôsob 
vyjadrenia priebehu nadmorskej výšky. Po spustení nástroja Hillshade sa zobrazí dialógové 
okno s nasledovnými možnosťami (obrázok 40): 

Input raster••  – digitálny model terénu, v ktorom sa nachádza priebeh výškovej repre-
zentácie reliéfu;

Output raster •• – výsledná rastrová reprezentácia, v ktorej sa bude nachádzať odvode-
né tieňovanie reliéfu (obrázok 41);

Azimuth (optional) •• – uhol dopadu osvetlenia v rozsahu od 0° do 360°, resp. z ktorej 
svetovej strany bude osvetlený reliéf; 

Altitude (optional) •• – uhol zdroja dopadu osvetlenia nad horizontom od 0° do 90°;

Obrázok 40
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Model shadows (optional) •• – typ tieňovania, zvolená možnosť vytvorí model lokál-
neho osvetlenia s hodnotami od 0 (najtmavšie miesta) do 255 (najsvetlejšie mies-
ta), pričom výsledok je ovplyvnený uhlom a azimutom dopadajúceho svetla vrátane 
vzniknutých tieňov. Bez zvolenej možnosti sa vytvorí lokálny model, kde nie sú ge-
nerované vrhané tiene;

Z  factor (optional) •• – násobok vstupnej výškovej reprezentácie reliéfu, t. j. číselné 
hodnoty priradené k DTM môžeme násobiť nami zadanou hodnotou. Zobrazenie te-
rénu musí byť značne prevýšené, aby sa prispôsobil naším subjektívnym predstavám. 
Týmto parametrom môžeme subjektívne prispôsobiť prevýšenie reliéfu.

3.3.2. Farebné odstupňovanie výšok
Metóda farebnej hypsometrie spočíva vo vyfarbení areálov definovaného rozpätia nad-

morskej výšky určitou farbou alebo jej odtieňom výslednej farebnej legendy (obrázok 42). 
Používa sa hlavne na mapách malých mierok alebo 
na účely vyjadrenia reliéfu veľkých územných cel-
kov, napr. kontinentov. Najčastejšie sa na farebné 
znázornenie reliéfu používa tzv. Peuckerova farebná 
škála, kde sú nížiny vyfarbené zelenou a s narastajú-
cou nadmorskou výškou sú ďalšie vrstvy vyfarbené 
žltou až hnedou farbou. Zastavaným územiam je 
priradená biela farba. Pre plochy morí a oceánov sa 
používajú rôzne odtiene modrej zohľadňujúc baty-
metrické údaje, kde použitý tmavší odtieň znamená 
väčšiu hĺbku. 

Obrázok 41

Obrázok 42
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V  prostredí ArcMap vykonáme 
farebné odstupňovanie výšok reliéfu 
pomocou reklasifikácie hodnôt DTM 
do požadovaných areálov (Spatial 
Analyst Tools → Reclass → Reclas-
sify). Zobrazené dialógové okno ná-
stroja Reclassify ponúka nasledovné 
možnosti (obrázok 43): 

Input raster••  – digitálny model 
terénu, v  ktorom sa nachádza 
priebeh výškovej reprezentácie 
reliéfu.

Reclass field •• – atribútové pole, 
ktorého hodnoty budú reklasi-
fikované.

Reclassification •• – zobrazenie 
rozpätia hodnôt na vstupe 
(Old Value) a  nových hodnôt 
na výstupe (New Value). Tla-
čidlom Classify určujeme počet areálov. Ostatné tlačidlá majú doplnkový charakter, 
napr. uloženie reklasifikačnej tabuľky, pridanie nového areálu atď.

Output raster •• – výsledná rastrová reprezentácia, v ktorej sa bude nachádzať farebné 
odstupňovanie výšok. 

Change missing values to NoData (optional) •• – hodnotám, ktoré sa nenachádzajú 
v reklasifikovanom rozpätí, bude priradená hodnota „NoData“. 

3.3.3. Generovanie vrstevníc z DTM
Vrstevnice môžeme definovať ako izolínie (čiary) spájajúce miesta s  rovnakou nad-

morskou výškou. V realite ide o fiktívne čiary, ktoré v mapách vyjadrujú výškopisný obsah 
(obrázok 44). V prostredí ArcMap máme k dispozícii nástroj s názvom Contour aplikácie 
ArcToolbox (Spatial Analyst Tools → Surface → Contour), ktorým generujeme vrstevni-
ce z DTM automaticky. Zobrazené dialógové okno 
nástroja Contour ponúka nasledovné možnosti (ob-
rázok 45): 

Input raster••  – digitálny model terénu, v kto-
rom sa nachádza priebeh výškovej reprezen-
tácie reliéfu,
Output polyline features •• – výsledná vektoro-
vá reprezentácia vrstevníc,

•• Contour interval – výškový interval medzi 
vrstevnicami,
Base contour (optional) •• – generovanie vrs-
tevníc pod a nad uvedenou hodnotou.

Obrázok 43

Obrázok 44
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Otázky:

Čo sa chápe pod pojmom morfometrická analýza reliéfu?1.	

Aký je rozdiel medzi topickými a chorickými parametrami reliéfu?2.	

Akým nástrojom sa odvodzujú orientácie reliéfu?3.	

Akým nástrojom sa odvodzujú sklony reliéfu?4.	

Akým nástrojom sa odvodzujú krivosti reliéfu?5.	

Na základe akého dátového vstupu je možné odvodiť parametre vidi-6.	
teľnosti a vzdialenosti?

Pomocou akých nástrojov sa znázorňuje reliéf?7.	

Obrázok 45
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4. 3D zobrazenie geografických informácií
Kapitola s názvom „3D zobrazenie geografických informácií“ je zameraná na prácu s roz-

šírením 3D Analyst. Pomocou tohto rozšírenia dokážeme posúvať konvenčné dvojrozmerné 
zobrazenie do dynamického trojrozmerného pohľadu. 

Hlavným cieľom používania rozšírenia 3D Analyst je vytvárať, analyzovať a zobrazovať 
geografické informácie v 3D prostredí. Možnosť trojdimenzionálneho zobrazenia geografic-
kých informácií pomáha vizualizovať rôzne prebiehajúce procesy v krajinnej sfére, genero-
vať 3D pohľady, konštruovať rezy a priečne profily, počítať zmeny objemov 3D štruktúr nad 
alebo pod povrchom. 

Rozšírenie 3D Analyst pracuje so všetkými dostupnými dátovými formátmi, t. j. TIN, 
rastrovou a vektorovou dátovou reprezentáciou. Základným predpokladom je, aby vstupné 
dátové formáty obsahovali okrem polohových údajov aj informácie o ich výškovom umiest-
není, resp. Z súradnice bodov definujúcich jednotlivé štruktúrne tvary. Podľa týchto hodnôt 
je možné modelovať prvky a povrchy v 3D zobrazení.

4.1. 3D dátový vstup
Modelovanie javov a  fenoménov v  trojrozmernom prostredí je podmienené vstupom 

takých dát, ktoré obsahujú tzv. komplexnú polohovú informáciu jednotlivých bodov – tro-
jicu súradníc [X, Y, Z]. V prípade práce s povrchom je najčastejším vstupom DTM, a to buď 
v podobe rastra alebo TIN modelu. Pri práci s vektorovými dátami s diskrétnym charakte-
rom je potrebné vytvoriť 3D prvkovú reprezentáciu.

4.2. Tvorba TIN modelu
TIN rozdeľuje povrch na súbor neprekrývajúcich sa trojuholníkov súvisle popisujúci 

priestor. TIN dátovú reprezentáciu môžeme vytvoriť z akejkoľvek kombinácie vektorových 
prvkov alebo rastrových dát (obrázok 46). Proces vytvárania TIN vychádza z tzv. Delaunayho 
triangulácie, ktorá sa vykonáva pre body, línie alebo polygóny s výškovými hodnotami. Troj-
uholníky sú tvorené uzlami a hranami. Uzly ako výškové body (Vertex/Vertices) s obsahom 
hodnôt súradnicových osí X, Y a Z pred-
stavujú koncové body trojuholníkov. Každý 
uzol je spojený hranou, pričom z každého 
uzla vychádzajú minimálne 2 hrany. Každý 
trojuholník pozostáva z bodov a hrán, čím 
vytvára základnú plôšku terénu, tzv. fazetu. 
Z každej fazety je následne možné získať jej 
sklon, orientáciu alebo jej obsah.

TIN model môžeme vytvoriť v prostre-
dí aplikácie ArcMap, ale aj v aplikácii Arc
Scene. Nástroje potrebné na  tvorbu TIN 
modelu sa nachádzajú v  aplikácii Arc
Toolbox, ktorú je možné spustiť v prostredí 
ArcMap alebo v ArcScene. Prvým nástro-
jom je Create Tin v  aplikácii ArcToolbox Obrázok 46
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(3D Analyst Tools → Data Management → TIN → Create Tin). Zobrazené dialógové okno 
ponúka nasledovné možnosti (obrázok 47):

Output TIN••  – výsledná TIN dátová reprezentácia.

Coordinate System (optional)••  – definovanie súradnicového systému výsledného 
TIN dátového modelu.

Input Feature Class (optional) •• – definovanie vstupu, podľa ktorého sa vytvorí TIN 
dátový model. Každému jednému vstupu je potrebné zadefinovať parametre, podľa 
ktorých bude vytvorený TIN model:

Input Features •• – vektorový vstup vo forme bodu, línie alebo polygónu,

Height Field •• – atribút výškovej reprezentácie,

SF Type••  – výber typu metódy, akou sa geometria prvkov bude transformovať do 
TIN modelu. Možnosti s  označením Hard alebo Soft definujú prechod medzi 
hranami trojuholníkov v  prípade neskoršie-
ho konvertovania na rastrovú reprezentáciu. 
Označenie Hard je určené pre náhlu zmenu, 
Soft pre postupnú zmenu hodnôt. Každému 
typu geometrie vstupných prvkov je daná roz-
dielna ponuka:

Masspoints 1.	 – výšková reprezentácia po-
mocou bodov,

Hardline/Softline 2.	 – výšková reprezentácia 
pomocou línií. Na obrázku 48 je znázor-
nený rozdiel medzi metódami Masspoints 
a Hardline/Softline,

Hardclip/Softclip 3.	 – priestorové ohraniče-
nie tvorby TIN modelu (obrázok 49),

Obrázok 47

Obrázok 48

Obrázok 49
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Harderase/Softerase 4.	 – definovanie plochy 
výrezu v TIN modeli (obrázok 50),
Hardreplace/Softreplace 5.	 – definovanie 
plôch s konštantnou výškou v TIN modeli 
(obrázok 51),
Hardvaluefill/Softvaluefill 6.	 – výber ploš-
ných prvkov, ktoré budú súčasťou výsledné-
ho TIN modelu a zároveň dôjde k retrian-
gulácii povrchu (obrázok 52). 

Tag Field •• – špecifikácia atribútu, ktorý sa bude na-
chádzať vo výslednom TIN modeli. Ide o hodnoty, 
ktoré majú význam napr. pre symbologickú úpravu 
výsledného TIN modelu. 

Constrained Dulaunay (optional) •• – špecifikácia metódy triangulácie v oblasti spája-
nia uzlov. Výberom tejto možnosti docielime zlučovanie vedľa seba ležiacich hrán do 
jednej hrany. Bez výberu tejto možnosti bude každá hrana v TIN modeli umiestnená 
osobitne. 

4.2.1. Konverzia rastra na TIN
TIN dátovú reprezentáciu môžeme vytvoriť aj z rastrovej reprezentácie. Na tento účel 

je k dispozícii nástroj s názvom Raster to TIN. Hlavným účelom konverzie je vytvoriť ne-
pravidelnú trojuholníkovú sieť podľa hodnôt Z súradníc buniek rastrového vstupu, ktoré sú 
prisúdené ich stredom. Po spustení nástroja Raster to TIN v aplikácii ArcToolbox (3D Ana-
lyst Tools → Conversion → From Raster → Raster to TIN) sa zobrazí okno s nasledovnými 
možnosťami (obrázok 53):

Input Raster1.	  – vstupná rastrová reprezentácia, napr. DTM; 
Output TIN 2.	 – výsledná TIN dátová reprezentácia, v ktorej sa bude nachádzať napr. 
DTM vo forme trojuholníkovej siete;

Obrázok 50

Obrázok 51

Obrázok 52
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Z  Tolerance (optional)3.	  – maxi-
málny povolený rozdiel hodnôt 
Z súradnicovej osi medzi vstupom 
a výstupom. Preddefinovaná tole-
rancia je 1/10 rozsahu Z  hodnôt 
vstupného rastra;

Maximum Number of Points (op-4.	
tional) – maximálny možný počet 
bodov, podľa ktorých sa vytvorí 
TIN model;

Z  factor (optional) 5.	 – násobok 
vstupnej výškovej reprezentácie.

4.2.2. Konverzia TIN na raster
Dátový formát TIN môžeme konver-

tovať na rastrový formát pomocou proce-
su interpolácie z  výškovej základne TIN 
modelu. Na tento účel máme k dispozícii 
nástroj s  názvom TIN to Raster v  Arc
Toolbox (3D Analyst Tools → Conver-
sion → From TIN → TIN to Raster). Po 
jeho spustení sa zobrazí okno s nasledov-
nými možnosťami (obrázok 54): 

Input Raster1.	  – vstupná reprezen-
tácia TIN dátového modelu, napr. 
DTM.

Output Raster2.	  – výstupná rastro-
vá reprezentácia. V  prípade defi-
novania konkrétnej súborovej prípony bude rastrová reprezentácia uložená do iného 
formátu, než je preddefinovaný ESRI Grid. Ak chceme uložiť raster do súborového 
formátu TIF, za názov súboru pridáme príponu .tif.

Output Data Type (optional) 3.	 – definovanie dátového typu výstupnej rastrovej repre-
zentácie. K dispozícii máme dve možnosti:

FLOAT •• – 32 bitové desatinné číslo,

INT •• – celočíselná hodnota.

Method (optional)4.	  – výber interpolačnej metódy, ktorou sa vytvorí výstupná rastro-
vá reprezentácia. K dispozícii máme dve možnosti:

LINEAR •• – lineárna interpolácia, ktorá pristupuje k  TIN trojuholníkom ako 
k rovnej ploche. Každej výstupnej bunke je priradená výška na základe hodnoty 
stredu bunky a roviny trojuholníka.

NATURAL_NEIGHBORS •• – interpolácia najbližšieho suseda, ktorá vytvorí vy-
hladenejší povrch než lineárna metóda. 

Obrázok 53

Obrázok 54
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Sampling Distance (optional)5.	  – definovanie výstupnej veľkosti bunky pomocou:

OBSERVATIONS •• – počtu buniek na najdlhšej strane výstupného rastra,

CELLSIZE •• – priameho zadania veľkosti bunky. 

Z factor (optional) 6.	 – násobok vstupnej výškovej reprezentácie.

4.2.3. Tvorba 3D prvkov
3D prvky predstavujú diskrétnu vektorovú dátovú reprezentáciu, umiestnenú v priestore 

definovanom pomocou súradnicových osí X, Y a Z. Kľúčovou vlastnosťou je hodnota Z sú-
radnicovej osi. Pomocou tejto hodnoty 
vieme prvky zobrazovať v  3D dimenzii 
a  následne ich  môžeme podrobiť rozlič-
ným priestorovým analýzam. Prvky s ob-
sahom Z súradnicových hodnôt môžeme 
vytvoriť viacerými spôsobmi. Najčastejšie 
používaným je nástroj s názvom Feature 
To 3D By Attribute, ktorý je umiestne-
ný v  aplikácii ArcToolbox (3D Analyst 
Tools → 3D Features → Feature To 3D 
By Attributes). Po spustení nástroja sa 
zobrazí dialógové okno s  nasledovnými 
možnosťami (obrázok 55):

Input Features 1.	 – vstupná vrstva 
vektorových prvkov,

Output Raster Feature Class 2.	 – výstupná 3D vrstva vektorových prvkov,

Height Field 3.	 – atribút s  hodnotami, ktoré definujú výšky bodov popisujúcich 3D 
prvky,

To Height Field (optional) 4.	 – atribút s hodnotami, definujúcimi koncové výšky línio-
vých prvkov v priestore. Použitím sekundárnej definície výšok dosiahneme výsledok, 
v ktorom bude každej línii priradená okrem začiatočnej hodnoty výšky Z aj koncová 
výška z druhého výškového poľa. Výška ostatných uzlov bude interpolovaná z hod-
nôt prvého a posledného uzla, t. j. začiatočného a koncového.

Ďalšia možnosť tvorby 3D prvkov je pomocou nástrojov umiestnených na lište 3D 
Analyst (obrázok 56), ktorú spustíme v hlavnom menu položkou Customize → Toolbars 
→ 3D Analyst. Nástroje lišty budú k dispozícii len za tej podmienky, ak v zozname vrstiev 
máme umiestnenú TIN alebo rastrovú reprezentáciu s obsahom hodnôt Z súradníc. Výstu-
pom sú grafické objekty, ktoré sa upravujú a exportujú (na vrstvu geografických informácií) 
lištou Draw. Na lište 3D Analyst máme na účely vytvárania 3D prvkov k dispozícii nasle-
dovné nástroje:

Obrázok 55

Obrázok 56
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••  Create Contour – vo zvolenom priestore vytvoríme grafické objekty – vrstevnice,

••  Create Steepest Path – od zvoleného priestoru vytvoríme grafický objekt – spá-
dovú krivku,

••  Interpolate Point – tvorba bodových grafických znakov,

••  Interpolate Line – tvorba líniových grafických znakov,

••  Interpolate Polygon – tvorba polygónových grafických znakov.

4.3. ArcScene
ArcScene je aplikácia, ktorá slúži na analýzu dát a ponúka prostredie na 3D vizualizáciu 

a animáciu. Koncept prostredia aplikácie je veľmi podobný aplikácii ArcMap. Hlavný rozdiel 
je v mapovom okne, ktoré obsahuje 3D prostredie zobrazenia údajov. 

Podobnou aplikáciou je ArcGlobe, ktorá je určená na globálnu „real-time“ vizualizáciu 
väčšieho množstva dát v menších mierkach s možnosťou 2D/3D symbologickej úpravy.

4.3.1. Zobrazenie 3D údajov
Do prostredia aplikácie ArcScene sa vrstvy geografických informácií pridávajú rovna-

kým spôsobom ako v aplikácii ArcMap, avšak geografické informácie sú zobrazené v per-
spektívnom pohľade. Vrstvy, ktoré obsahujú hodnoty Z súradníc, budú zobrazené pomocou 
troch dimenzií. Zároveň máme k dispozícii lištu Tools, ktorá obsahuje navigačné nástroje 
výberu a identifikácie (obrázok 57). 

Geografické informácie sa ukladajú do scény, ktorá je určitou alternatívou k dátovému 
rámu. Pri akejkoľvek ďalšej práci je potrebné nastaviť globálne vlastnosti celej scény, t. j. 

Obrázok 57
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farbu pozadia, osvetlenie scény, vertikál-
ne skreslenie, súradnicový systém, ani-
movanú rotáciu a popisné údaje k scéne. 
Dialógové okno s názvom Scene Proper-
ties (obrázok 58) otvoríme dvojklikom na 
hlavnú položku v okne obsahu – v zozna-
me vrstiev. 

Každú pridanú vrstvu môžeme pros
tredníctvom jej vlastností upraviť, a  to 
v rozsahu symbológie, výšky, súborového 
zdroja, zobrazenia, vykreslenia atď. Po-
zornosť je potrebné venovať záložke Base 
Heights v  dialógovom okne vlastností 
vrstvy (Layer Properties). V záložke výš-
kovej základne (obrázok 59) definujeme 
výškový zdroj (Elevation from surface) 
a  môže ňou byť okrem pôvodných výš-
kových hodnôt zdrojovej vrstvy aj iná 
vrstva. Ďalej môžeme výškový rozsah 
vrstvy vertikálne skresliť, relatívne znížiť alebo prevýšiť reliéf v smere osi Z zadaným koefi-
cientom v časti okna s názvom Elevation from feature. Poslednou možnosťou tejto záložky 
je hodnota vertikálneho posunu (Offset), ktorou danú vrstvu hladinovo posúvame vzhľa-
dom k celej scéne.

Obrázok 58

Obrázok 59
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4.3.2. Vytváranie animácií
Prostredie aplikácie ArcScene ponúka súbor nástrojov, ktorými dokážeme vytvoriť dyna-

mické animácie – prelety v priestore mapového okna. Dynamické prelety ukladáme do vi-
deo záznamu a následne môžeme vykonať ich export do štandardných súborových formátov. 
Vytvárame ich pomocou nástrojov lišty Animation (obrázok 60), ktorú spustíme v položke 
hlavného menu Customize→ Toolbars → Animation. Pred 
začiatkom tvorby je potrebné oboznámiť sa s  typmi kľúčo-
vých snímok (Keyframe) ako základného prvku pri tvorbe 
animácií. Kľúčové snímky, ku ktorým je zapisovaná zmena 
parametrov, sú určitými značkami na trase (časovej osi). 
Takto vytvorená časová os predstavuje hlavný scenár animá-
cií. K dispozícii máme nasledovné typy kľúčových snímok:

•• Layer – kľúčové snímky vytvárame pomocou zmeny 
parametrov vrstvy, 

•• Scene – kľúčové snímky vytvárame pomocou zmeny 
parametrov scény,

•• Camera – kľúčové snímky vytvárame pomocou 
zmien pohľadu na obsah scény v mapovom okne.

Dynamické prelety môžeme vytvárať viacerými spôsobmi. V každom jednom spôsobe 
ide o tvorbu kľúčových snímok daného typu. Vytvárame ich nástrojom  Create Keyframe, 
ktorý je umiestnený v padajúcom menu Animation lišty Animation alebo pomocou  Ani-
mation Manager z padajúceho menu Animation. 

Manažér animácií (  Animation Manager) ponúka pracovné prostredie na tvorbu ani-
mácií a ich úpravu (obrázok 61). Okno manažéra animácií pozostáva z troch základných zá-
ložiek. Prvou je zoznam kľúčových snímok, druhou je zoznam tzv. časových osí a poslednou 
je pohľad na samotný časový scenár animácie.

4.3.3. Export scény a animácie
Vytvorenú štruktúru animácie je potrebné uložiť do formátu ArcScene dokumentu, čo 

zabezpečí uchovanie všetkých parametrov vrstiev, scény a relatívnej alebo absolútnej cesty 
k zdrojovým dátam. Zároveň v dokumente ArcScene ukladáme aj štruktúru animácie.

Obrázok 60

Obrázok 61
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Export scény môžeme vykonať prostredníc-
tvom statického exportu do formy 2D alebo 3D 
obrázka, t. j. aktuálneho pohľadu na kompozíciu 
a  obsah mapového dokumentu. Export vyko-
náme položkou hlavného menu File → Export 
Scene.

Export animácie do súboru .asa (aby sme 
danú animáciu mohli použiť v  inom ArcScene 
dokumente) vykonáme pomocou padajúceho 
menu Animation a nástroja  Save Animation 
File.

Export animácie do video formátu vykoná-
me nástrojom  Export Animation, ktorý sa na-
chádza v padajúcom menu Animation. Najskôr 
však musíme pomocou navigačných nástrojov 
nastaviť dĺžku výslednej animácie. Dialógové 
okno navigačných nástrojov (obrázok 62) spus-
tíme ikonkou  Open Animation Controls. Export animácie do video formátu bude určený 
veľkosťou mapového okna, otvorenými dialógovými oknami a spustenými lištami, ktoré sa 
priamo premietnu do výslednej animácie. Export do konkrétneho video formátu a jeho pa-
rametrov je podmienený multimediálnym rozhraním operačného systému. Rýchlosť vytvá-
rania video súboru je priamo úmerná dĺžke animácie, náročnosti trajektórie generovaného 
preletu a hardvérovej konfigurácii.

Otázky:

Aké prostredie, resp. priestorovú dimenziu,  1.	
ponúka rozšírenie 3D Analyst?

Čo sa chápe pod skratkou a termínom TIN?2.	

Pomocou akých nástrojov je možné vytvoriť tzv. TIN model?3.	

Akým nástrojom sa vytvárajú 3D vektorové prvky  4.	
geografických informácií?

Aké prostredie ponúka aplikácia 5.	 ArcScene?

Čo znamená kľúčová snímka – 6.	 Keyframe?

Obrázok 62
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5. Vodstvo a prúdenie
Kapitola s názvom „Vodstvo a prúdenie“ je zameraná na hydrologické analýzy pomocou 

rozšírenia Spatial Analyst. Súborom nástrojov budeme analyzovať reliéf a odvodzovať zá-
kladné hydrologické charakteristiky, akými sú smer prúdenia, práca s priehlbinami, resp. 
depresiami, tvorba siete vodných tokov a povodí atď.

Reliéf je podľa Miklósa a  Izakovičovej (1997) považovaný za základný rámec pohybu 
povrchových vôd. Preto je väčšina charakteristík viazaných na parametre reliéfu ako gravi-
tačne transformovaného média, a nie vody. Avšak voda je v našich podmienkach hlavným 
modelačným činiteľom reliéfu.

Voda je jednou z najdôležitejších podmienok života na Zemi a základnou zložkou ži-
votného prostredia. Tvorí hydrosféru, je podstatnou zložkou biosféry a zároveň je súčasťou 
ostatných geosfér Zeme. Je nielen životne dôležitým ekologickým a ekonomickým zdrojom, 
ale aj základnou charakteristikou prírodnej krajiny. 

Prostredie GIS ponúka široké spektrum nástrojov analýzy rôznych parametrov viaza-
ných k povrchovým vodám. Nástroje určené na hydrologické analýzy sú súčasťou rozšírenia 
Spatial Analyst a organizované sú v aplikácii ArcToolbox v zložke Hydrology.

5.1. Smer prúdenia
Jednou zo základných charakteristík hydrologických analýz je stanovenie smeru 

prúdenia vody po povrchu. Pomocou nástroja Flow Direction z aplikácie ArcToolbox 
(Spatial Analyst → Hydrology → Flow Direction) vykonáme analýzu smeru prúdenia 
vody z  buniek alebo do buniek rastrovej re-
prezentácie reliéfu (DTM). Smer prúdenia sa 
určuje vzájomným porovnávaním výškových 
hodnôt buniek v smere najstrmšieho klesania 
od jednej bunky k druhej. Nástrojom stanoví-
me 8 smerov prúdenia tak, ako je to znázor-
nené na obrázku 63. Zobrazené okno nástroja 
Flow Direction ponúka nasledovné možnosti 
(obrázok 64):

Input raster1.	  – digitálny model terénu, 
v  ktorom sa nachádza priebeh výškovej 
reprezentácie,

Output flow direction raster 2.	 – výsledná 
rastrová reprezentácia s obsahom smero-
vého prúdenia vody po povrchu osobitne 
pre každú bunku (obrázok 65),

Force all edge cells to flow outward (op-3.	
tional) – voľbou tejto možnosti sa prú-
denie okrajových buniek rastra presunie 
smerom von,

Obrázok 63

Obrázok 64
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Output drop raster (optional) 4.	 – rastrová reprezentácia, ktorej výsledkom sú hodnoty 
vypočítané bunkám ako výsledok pomeru maximálnej zmeny výšky v smere prúde-
nia. Hodnoty sú vyjadrené v percentách.

Obrázok 65

5.2. Identifikácia chýb DTM a ich oprava
Pri práci s hydrologickými analýzami je potrebné pracovať len s takým výškovým 

modelom, ktorý neobsahuje žiadne chyby. Reprezentácia spojitého modelu priebehu 
nadmorskej výšky (DTM) prináša so sebou rôzne chyby. Najčastejšími sú nepravé prie-
hlbiny (sinks – depresie) alebo vyvýšeniny (peaks – vrcholy) ako náhle zmeny hodnôt 
bunky oproti jej okoliu. Tieto chyby vytvárajú tzv. falošné ponory alebo bariéry, kde sa 
odtok pri týchto bunkách ukončí. Avšak niektoré priehlbiny a vyvýšeniny majú priro-
dzený charakter a musia byť súčasťou DTM. Ide napr. o rôzne skalné útvary alebo po-
nory v krasových oblastiach či antropogénne vzniknuté depresie (ťažbou, bagrovaním 
atď.).

Identifikácia chýb DTM pomocou rastra je založená na 
analýze hodnôt smerového prúdenia. Priehlbina alebo vy-
výšenina je vnímaná ako bunka, ku ktorej nie je možné pri-
radiť jednu z ôsmich hodnôt smeru prúdenia (obrázok 66). 

Pomocou nástroja Sink  aplikácie ArcToolbox (Spatial 
Analyst → Hydrology → Sink) vykonáme identifikáciu 
chýb. Zobrazené okno nástroja Sink ponúka nasledovné 
možnosti (obrázok 67): 

Input flow direction raster 1.	 – vstupná rastrová repre-
zentácia, ktorá obsahuje hodnoty smeru prúdenia, Obrázok 66
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Output raster 2.	 – výsledná rastrová re-
prezentácia, v  ktorej sa budú nachádzať 
identifikované chyby, t. j. priehlbiny alebo 
vyvýšeniny s hodnotami od jedna až po 
celkový počet (poradové číslo detekova-
nej priehlbiny).

Pomocou nástroja Fill aplikácie ArcToolbox 
(Spatial Analyst → Hydrology → Fill) odstrá-
nime identifikované chyby. Zobrazené dialógo-
vé okno ponúka nasledovné možnosti (obrázok 
68): 

Input surface raster 1.	 – vstupná rastrová 
reprezentácia smerov prúdenia.

Output raster 2.	 – výsledná rastrová re-
prezentácia, v  ktorej sa bude nachádzať 
opravená vstupná výšková reprezentácia. 
Vykonanú opravu je možné verifikovať 
opätovným aplikovaním nástroja Sink.

Z limit (optional) 3.	 – definujeme maximál-
ny možný hĺbkový alebo výškový limit, do 
ktorého sa budú odstraňovať chyby. Touto hodnotou eliminujeme opravu aj takých 
chýb, ktoré v konečnom dôsledku nemusia byť chybami. Napríklad, ak špecifikuje-
me hodnotu 6, čo v danom zobrazovacom systéme znamená 6 m, nedôjde k oprave 
žiadnych chýb, ktoré sú hlbšie alebo vyššie než 6 m. V prípade vynechania tejto voľby 
dôjde k odstráneniu všetkých detekovaných lokálnych priehlbín a vyvýšenín.

5.3. Akumulácia prietoku – odvodňovacia sieť
Každá vstupná bunka disponuje rovnakou hodnotou, ktorá predstavuje množstvo vody. 

Podľa smeru prúdenia sa bunkám vypočíta akumulácia množstva vody, to znamená, že 
dôjde ku kumulácii hodnôt pre každú bunku zo všetkých buniek v smere prúdenia. Bunky, 
ktoré obsahujú vysoké číselné hodnoty, vyjadrujú oblasti koncentrovaného odtoku. Vý-
počet akumulácie odtoku vykonáme nástrojom Flow Accumulation (Spatial Analyst → 
Hydrology → Flow Accumulation). Zobrazené 
dialógové okno ponúka nasledovné možnosti 
(obrázok 69): 

Input flow direction raster 1.	 – vstupná ras-
trová reprezentácia, ktorá obsahuje hod-
noty o smere prúdenia.

Output accumulation raster2.	  – výsledná 
rastrová reprezentácia akumulácie odto-
ku. Výsledok obsahuje hodnoty odtoku 
od jednej bunky toku k druhej. Ak prvá 
bunka mala hodnotu 1, druhá bude mať 

Obrázok 67

Obrázok 68

Obrázok 69



50

hodnotu 2 atď. Výsledok môže byť použitý ako miera odtoku dažďovej vody pri po-
tenciálnych zrážkových javoch. Bunky s najväčšími hodnotami sú vlastne detekova-
nými korytami vodných tokov (obrázok 70).

Input weight raster (optional) 3.	 – výsledná rastrová reprezentácia, ktorej hodnoty sú 
vo všetkých bunkách rastra výsledkom prenásobenia hodnôt smeru prúdenia kon-
krétnymi hodnotami (váhami). Najčastejšie používanou hodnotou je skutočne na-
merané množstvo zrážok, t. j. hodnoty smeru prúdenia sa budú násobiť reálnymi 
hodnotami (váhami) zrážok.

Output data type (optional) 4.	 – výber typu výsledných hodnôt, a to buď celočíselných 
(INTEGER) alebo desatinných (FLOAT).

Obrázok 70

5.3.1. Sieť vodných tokov
Z rastrovej reprezentácie akumulácie odtoku je možné odvodiť sieť vodných tokov. Odvo-

denie vykonáme pomocou reklasifikácie (Spatial Analyst → Reclass → Reclassify) alebo ma-
povej algebry (Spatial Analyst → Map Algebra → Raster Calculator). Základným princípom 
je výber buniek s vyššími číselnými hodnotami. Napríklad pomocou reklasifikácie vytvoríme 
len jeden areál s hodnotami od 500 a viac, ostatné hodnoty budú „NoData“ (obrázok 71).
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Obrázok 71

5.3.2. Článkovanie tokov
	 Rozdelenie súvislej líniovej reprezentácie odvodených vodných tokov na jednotlivé úse-
ky vykonáme pomocou vrstvy smeru prúdenia. Nástroj Stream Link (Spatial Analyst → 
Hydrology → Stream Link) priradí bunkám jedného úseku rovnakú hodnotu. Zobrazené 
dialógové okno ponúka nasledovné možnosti (obrázok 72):

Input stream raster 1.	 – vstupná rastrová re-
prezentácia odvodených vodných tokov,

Input flow direction raster 2.	 – vstupná ras-
trová reprezentácia, ktorá obsahuje hod-
noty smerov prúdenia,

Output raster 3.	 – výsledná rastrová repre-
zentácia, v ktorej sa budú nachádzať vod-
né toky rozdelené na jednotlivé úseky, 
vždy od prameňa po najbližší sútok , resp. 
od sútoku po sútok. 

5.3.3. Klasifikácia tokov
	 Vodné toky rozdelené na úseky môžeme klasifikovať na základe počtu prítokov. Klasifi-
káciu vykonáme pomocou vrstvy smeru prúdenia. Nástroj Stream Order (Spatial Analyst 
→ Hydrology → Stream Order) priradí jednotlivým úsekom vodného toku číselný rád. Zo-
brazené dialógové okno ponúka nasledovné možnosti (obrázok 73): 

Obrázok 72
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Input stream raster 1.	 – vstupná rastrová re-
prezentácia rozdelených vodných tokov,

Input flow direction raster 2.	 – vstupná ras-
trová reprezentácia, ktorá obsahuje hod-
noty smeru prúdenia,

Output raster 3.	 – výsledná rastrová repre-
zentácia, v ktorej sa budú nachádzať kla-
sifikované vodné toky, 

Method of stream ordering (optional)4.	  – 
klasifikáciu vodných tokov môžeme vy-
konať metódami: 

STRAHLER••  – toky v pramennej ob-
lasti majú prvý rád, ďalší rád nasleduje 
hneď za sútokom (miestom spojenia 
aspoň dvoch) rovnakých tokov pred-
chádzajúcich rádov (obrázok 74);
SHREVE •• – pramenná oblasť je prvým 
rádom, ďalší rád nasleduje hneď za 
sútokom (miestom spojenia) rovna-
kých tokov predchádzajúcich rádov, 
avšak s  číslovaním v  zmysle prírast-
kového – akumulačného – pravidla 
číselných hodnôt predchádzajúcich 
rádov (obrázok 75). 

5.3.4. Prevod rastra na vektor
Transformáciu rastrovej reprezentácie klasifikovaných vodných tokov na vektorový dáto-

vý formát uskutočníme nástrojom Stream to Feature (Spatial Analyst → Hydrology → Stre-
am to Feature). Nástroj je primárne určený na vektorizáciu prostredníctvom pomocnej vrstvy 
smeru prúdenia. Pomocná vrstva zohľadňuje rôzne prieniky medzi bunkami a ich vplyvy na 
ďalší priebeh vodného toku. Prevod rastra na vektor môžeme vykonať aj nástrojom Raster To 
Polyline (Spatial Analyst → Conversion Tools → 
From Raster → Raster To Polyline). Avšak tento 
nástroj neposkytuje možnosti zohľadnenia sme-
rového prúdenia, čím môže dochádzať ku chyb-
nej generalizácii výsledku (obrázok 76). Po spus-
tení nástroja Stream to Feature sa zobrazí okno 
s nasledovnými možnosťami (obrázok 77):

Input stream raster 1.	 – vstupná rastrová 
reprezentácia klasifikovaných vodných 
tokov,

Input flow direction raster 2.	 – vstupná ras-
trová reprezentácia, ktorá obsahuje hod-
noty smerov prúdenia,

Obrázok 73

Obrázok 76

Obrázok 75Obrázok 74
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Output polyline features 3.	 – výsledná vek-
torová reprezentácia vodných tokov,

Simplify polylines (optional) 4.	 – voľba me-
tódy generalizácie počtu uzlov (lomových 
bodov vektora). S  využitím voľby bude 
počet uzlov vo výslednom vektore repre-
zentujúcom tok redukovaný. Bez využitia 
voľby nedôjde k  žiadnej redukcii alebo 
generalizácii. 

5.4. Povodia a ústia tokov
Povodie sa definuje ako zberné územie vodných tokov, ktoré je ohraničené rozvodnicou. 

Povodie je najvýznamnejším reprezentantom vzťahu reliéfu a vodstva, je to vlastne priesto-
rová jednotka ohraničená morfometrickými parametrami reliéfu (Miklós, Izakovičová, 
1997). V rámci rozlišovacej úrovne môže byť jedno povodie súčasťou iného povodia. 

Príkaz Watershed (Spatial Analyst → Hydrology → Watershed) ohraničí oblasti (mik-
ropovodia) zvažujúce sa k  definovaným odtokovým bodom (ústia tokov – pour/outlet 
point), t. j. najnižšie položeným bodom pozdĺž rozvodnice. 

Na identifikáciu odtokových bodov využijeme výslednú rastrovú reprezentáciu nástro-
ja Flow Accumulation. Miesta s najväčšími hodnotami sú považované za odtokové body. 
Musíme ich manuálne vytvoriť pomocou vektorových bodov alebo rastrovej reprezentá-
cie (obrázok 78). Vytvorené odtokové body je následne potrebné upraviť, resp. spresniť na 
hodnoty akumulácie prietoku (Flow Accumulation). Takúto úpravu realizujeme nástrojom 

Obrázok 77

Obrázok 78
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Snap Pour Point (Spatial Analyst → Hydrology 
→ Snap Pour Point). V zobrazenom dialógovom 
okne nástroja Snap Pour Point sú nasledovné 
možnosti (obrázok 79):

Input raster or feature pour point data 1.	
– vstupná vektorová alebo rastrová repre-
zentácia ústia tokov.
Pour point field (optional)2.	  – voľba atri-
bútov k dátovému vstupu. V prípade vek-
torového vstupu je potrebné zadať čísel-
ný atribút. V  prípade rastrového vstupu 
pôjde len o  číselné hodnoty, ak sú ako 
desatinné čísla, budú prevedené na celo-
číselné.
Input accumulation raster 3.	 – rastrová re-
prezentácia akumulácie prietoku vytvo-
reného pomocou nástroja Flow Accumu-
lation.
Snap distance4.	  – maximálna vzdialenosť 
na vyhľadávanie buniek s vyššou prieto-
kovou hodnotou.

Povodia vytvoríme nástrojom Watershed. Po 
jeho spustení sa zobrazí dialógové okno s nasle-
dovnými možnosťami (obrázok 80):

Input flow direction raster 1.	 – vstupná rastrová reprezentácia, ktorá obsahuje hodno-
ty smerov prúdenia,
Input raster or feature pour point data2.	  – vektorová alebo rastrová reprezentácia ús-
tia tokov,
Pour point field (optional)3.	  – voľba atribútov pre ústia tokov,
Output raster 4.	 – výsledná rastrová reprezentácia povodia alebo povodí. Pre každý 
jeden odtokový bod, resp. ústie, bude vytvorené jedno povodie (obrázok 81).

Na automatickú tvorbu povodí, kde nebudú zohľadnené ústia tokov, využijeme nástroj 
Basin (Spatial Analyst → Hydrology → Basin).

Obrázok 79

Obrázok 80
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Otázky:

Čo je základným rámcom pohybu povrchových vôd?1.	

Akým nástrojom sa stanoví smer prúdenia?2.	

Ponúka aplikácia 3.	 ArcMap nástroje identifikácie a opravy chýb DTM?

Čo znamená akumulácia prietoku a ktorým nástrojom sa stanovuje?4.	

Ktorým nástrojom sa odvodzuje sieť vodných tokov a  ich následné 5.	
článkovanie?

Aké nástroje sú k dispozícii v aplikácii 6.	 ArcMap na tvorbu povodí?

Obrázok 81
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6. Analýza krajinnej štruktúry
Kapitola s názvom „Analýza krajinnej štruktúry“ je zameraná na kvantifikáciu krajin-

nej pokrývky pomocou súboru krajinných metrík. Číselné hodnoty metrík, t. j. stanovené 
ukazovatele, tvoria podklad účelových interpretácií prebiehajúcich ekologických procesov 
v krajine. 

Každý vymedzený priestor využívania krajiny a krajinného pokrytia má svoje základné 
charakteristiky. Krajina podľa Formana (2006) predstavuje špecifický objekt, resp. fenomén 
s atribútmi, ktoré je možné analyzovať, modelovať, pozmeňovať, interpretovať, hodnotiť atď. 
Pri elementárnom pohľade na krajinu sa ponúka obraz jej prvkov (krajinné prvky), ktoré sú 
usporiadané do určitej štruktúry, t. j. do priestorovej konfigurácie a krajinnej kompozície 
(Dunning et al., 1992). Krajinná štruktúra je určitou mozaikou, ktorá je zložená z kompo-
nentov striedajúcich sa viac-menej pravidelne (obrázok 82). Základnými prvkami sú plôšky, 
koridory a matrice (Forman, Godron, 1986). 

Obrázok 82

Povaha a charakter krajinných prvkov môžu nezávisle na sebe alebo spoločne ovplyvňo-
vať rôzne ekologické procesy prebiehajúce v krajinnej štruktúre (McGarigal, Marks, 1994). 
Krajinnú štruktúru kvantifikujeme prostredníctvom spektra indikátorov, akými sú napr. 
indexy krajiny alebo krajinné metriky. Podľa stanovených hodnôt je možné krajinnú štruk-
túru interpretovať do podoby kvalitatívnych ukazovateľov (napr. ekologickej významnosti 
krajiny). 

Kvantifikácia krajinnej štruktúry sa realizuje na úrovni plôšok (patch), tried (class) 
a krajiny (landscape). Niektoré metriky sa vzájomne prelínajú a majú duplicitný význam, 
preto sa interpretujú vo vzájomnej kombinácii. Krajinnými metrikami môžeme osobitne 
charakterizovať:

Priestorovú konfiguráciu•• , ktorá determinuje priestorový charakter, usporiadanie 
a orientáciu plôšok v rámci tried alebo krajinnej mozaiky. Priestorová konfigurácia 
krajiny reprezentuje priestorový charakter jednotlivých plôšok, ako je tvar, umiest-
nenie, orientácie atď. 
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Krajinnú kompozíciu•• , ktorá determinuje heterogenitu a početnosť plôšok v krajinnej 
mozaike, t. j. typy a množstvo krajinných prvkov. V krajinnej kompozícii sa plôšky 
priestorovo neanalyzujú. Nedochádza k analýze tvarov a priestorového umiestnenia. 
Na vyjadrenie krajinnej kompozície existujú rôzne kvantifikačné metódy, ako je napr. 
plošná výmera a diverzita prvkov a krajiny. 

Krajinné metriky sa zaraďujú do rôznych tematických skupín, napr. metriky výmery, 
metriky diverzity, metriky tvaru.

6.1. Dátový vstup
Analýza krajinnej štruktúry je podmienená určitým kvalitatívnym dátovým vstupom. 

Do analýz vstupuje dátová reprezentácia krajinného priestoru vo forme vektorového alebo 
rastrového formátu. Vzhľadom na obmedzené databázové rozhranie a najmenšiu rozlišova-
ciu úroveň (tvar bunky) rastrových formátov je vhodnejším vstupom vektorový formát.

Hlavným dátovým vstupom do analýz krajinnej štruktúry sú vrstvy geografických infor-
mácií, ktoré obsahujú štruktúrovanú abstrakciu krajinného priestoru. Abstrakcia pochádza 
z rôznych foriem zberu údajov, napr. pozemného, vzdušného alebo transformačného zberu 
údajov.

V našich podmienkach sa najčastejšie využíva transformačný a vzdušný zber. Pri trans-
formačnom ide hlavne o vektorizáciu rastrových topografických máp. Ďalšou silne rozví-
jajúcou sa metódou tvorby geografických informácií je vzdušný zber vo forme diaľkového 
prieskumu Zeme (DPZ). 

Kvalita výsledných analýz je priamo úmerná kvalite obsahu atribútovej tabuľky a správ-
nosti topologických vzťahov medzi prvkami. Chybné záznamy atribútovej tabuľky zbytočne 
duplikujú záznamy s rovnakým obsahom, resp. významom, dôsledkom čoho sa zvyšuje di-
verzita kategórií prvkov obsiahnutých vo vrstve geografických informácií. Vzájomné pre-
krývanie hraníc prvkov alebo prázdne miesta (topologické chyby) medzi prvkami majú ne-
gatívny dôsledok na správne stanovenie parametrov viazaných na tvar alebo veľkosť prvkov. 
Zároveň do analýzy krajinnej štruktúry vstupujú prvky v tzv. nezlúčenej podobe, t. j. každý 
prvok je reprezentovaný osobitným záznamom v atribútovej tabuľke.

6.2. Analýza krajinnej štruktúry v ArcMap
Analýza krajinnej štruktúry je postavená na matematicko-štatistickom základe. Výpo-

čet hodnôt krajinných metrík sa uskutočňuje niekoľkými spôsobmi. Prvým je manuálny 
výpočet podľa počtu prvkov, tried a merných jednotiek odvodených od výmery, obvodu, 
dĺžky atď. V tomto prípade postupujeme algoritmom určeným v matematických vzorcoch. 
Druhým spôsobom sú automatizované výpočty pomocou voľne šíriteľných a dostupných 
rozšírení, napr. Patch Analyst, ktorého producentom je Center for Northern Forest Eco-
system Research. Uvedené rozšírenie je možné stiahnuť z nasledovnej web stránky: http://
www.cnfer.on.ca/SEP/patchanalyst/.

Po inštalácii rozšírenia a  spustení aplikácie ArcMap je potrebné do hlavného menu 
umiestniť (v zmysle používateľskej príručky) novú položku s názvom Spatial Analyst, ktorá 
obsahuje nasledovnú ponuku (obrázok 83): 
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Obrázok 83

Dissolve Polygons••  – geoprocesingový nástroj, ktorý je určený na zlučovanie prvkov 
a ich atribútových záznamov. 

Intersect Polygons •• – geoprocesingový nástroj, ktorý je určený na výpočet geometric-
kého prieniku prvkov minimálne dvoch vstupných vrstiev. 

Create Core Areas •• – vytvorenie novej vrstvy s odpočtom výmery pozdĺž obvodových 
hraníc prvkov podľa špecifikovanej vzdialenosti (Buffer Size). 

Make Hexagon Regions••  – vytvorenie novej polygónovej vrstvy v tvare päťuholníkov, 
ktoré pokrývajú rozsah zadefinovaného výberu prvkov.

Add/Refresh Area and Perimeter Field •• – výpočet alebo aktualizácia plochy a obvodu 
prvkov.

Parse Species Composition String •• – separácia záznamov, ktoré obsahujú číselné kó-
dovania lesných porastov na samostatné atribúty. Ide o kódovanie, ktoré nie je možné 
aplikovať na naše podmienky.

Attribute Modeling •• – dialógové okno, ktoré ponúka tzv. atribútovú kalkulačku. Kal-
kulačkou vytvoríme alebo upravíme obsah zvoleného atribútu o hodnoty získané al-
goritmami, resp. príkazmi vo vzťahu k obsahu ostatných atribútov.

Set and Run Batch Processes •• – nastavenie dávkového súboru s poradím po sebe na-
sledujúcich operácií, ktoré sú viazané na nástroj Spatial Statistics.

Neighbourhood Mean••  – definovanie zón, v ktorých vstupné prvky majú podobné 
hodnoty. V definovanej vzdialenosti sa prvky s podobným atribútom kategorizujú 
do samostatných tried. 

Spatial Statistic •• – komplexný nástroj kvantifikácie krajinnej štruktúry pomocou roz-
siahleho súboru krajinných metrík.

Analysis by Regions •• – vykonávanie analýz pomocou krajinných metrík na úrovni 
tried a krajiny vo vzťahu k definovaným regiónom.
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6.3. Kvantifikácia krajinnej štruktúry
Kvantifikáciu krajinnej štruktúry vykonáme pomocou nástroja Spatial Statistic, ktorého 

spúšťacia položka sa nachádza v hlavnom menu Patch Analyst aplikácie ArcMap. V nástroji 
sú zahrnuté položky na výpočet krajinných metrík v kategórii hustota, veľkosť, tvar, diver-
zita, hranice, jadrové oblasti na úrovni tried alebo krajiny. Zobrazené dialógové okno je 
štruktúrované do nasledovných častí (obrázok 84):

Layers 1.	 – výber vrstvy geografických informácií, ktorá sa bude analyzovať.

Class 2.	 – výber východiskového atribútu, podľa ktorého sa uskutoční analýza. Atribút 
môže obsahovať číselné ale aj textové hodnoty. Determinujeme ním počet tried, t. j. 
rovnaké hodnoty v atribútových záznamoch predstavujú jednu triedu prvkov.

Analyze by 3.	 – úroveň vykonanej analýzy, t. j. analýzy na úrovni tried (Class) alebo 
analýzy na úrovni krajiny (Landscape). V  prípade výberu krajiny ako celku bude 
vykonaná analýza všetkých prvkov bez ohľadu na ich priradenie do tried. Výberom 
tried bude analýza vykonaná ku každej triede osobitne.

Output Table Name 4.	 – výsledná tabuľka s  obsahom analýz vo forme .dbf súboru. 
V prípade už existujúceho súboru (s rovnakým názvom) máme možnosť jeho prepi-
su (Overwrite) alebo pridania obsahu (Append).

General Statistics 5.	 – výber konkrétnych metrík, ktoré sú zaradené do jednej z nasle-
dujúcich tematických oblastí:

Area••  – analýza výmery jednotlivých tried a krajiny ako celku,
Patch Density and Size Metrics••  – analýza hustoty a veľkosti prvkov jednotlivých 
kategórií,

Obrázok 84
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Edge Metrics••  – analýza hrán,
Shape Metrics••  – analýza tvaru,
Diversity Metrics••  – analýza diverzity a rovnováhy,
Core Area Metrics••  – analýza jadrových oblastí, resp. zón, v nadväznosti na vý-
stupnú vrstvu nástroja Create Core Areas.

Advanced Options 6.	 – dátový formát vrstvy geografických informácií má určitý vplyv 
na výsledok analýz. Ak vrstva vznikla transformáciou rastra na vektor, využijeme 
možnosť Raster. Ak je vstupnou vrstvou originálny vektorový formát, využijeme 
možnosť Vector. 

Stanovené hodnoty krajinných metrík je možné interpretovať vo vzťahu k priebehu eko-
logických procesov na úrovni tried alebo krajiny. V zmysle Formana (2006); Turnera, Gard-
nera a O‘neilla (2001); Gergela a Trunera (2002) a McGarigala a Marksa (1994) uvádzame 
účelovú interpretáciu niekoľkých vybraných krajinných metrík:

1.	 Počet plôšok (Number of patches/NP) – zvyšuje a zároveň aj znižuje heterogenitu 
a rozlíšenie krajinnej mozaiky.

2.	 Priemerná veľkosť plôšky (Mean patch size/MPS) – výpočet vychádza z  počtu 
plôšok a výmery tried (Class area/CA). Rozsah hodnôt je limitovaný stupňom rozlí-
šenia a rozsahom krajinnej mozaiky. Výstupné hodnoty MPS poukazujú na fakt, že 
krajinné prvky, ktoré majú malé plošné zábery a sú zastúpené v menšom počte plôch 
(NP), vykazujú aj malé hodnoty indexu MPS. Naopak, čím je väčšia plocha s men-
ším počtom prvkov (NP), tým sú aj hodnoty MPS väčšie. Postupná redukcia veľkosti 
plôšok smeruje k fragmentácii krajinnej mozaiky. Priemernú veľkosť prvkov (MPS) 
je potrebné vždy interpretovať vo vzťahu k počtu plôch krajinných prvkov (NP) a ich 
výmere (CA). 

3.	 Štandardná veľkostná odchýlka (Patch Size Standard Deviation/PSSD) – reprezen-
tuje rozdiel veľkostí plôšok vo svojich kategóriách v rámci krajinnej mozaiky. Čím 
bližšie sú hodnoty k nule, tým majú zastúpené krajinné prvky podobnejšiu výmeru 
a krajina sa stáva homogénnejšou. Krajinný priestor ovplyvnený ľudskou aktivitou 
obsahuje zvyčajne viac uniformných a  veľkosťou jednotných prvkov než krajinný 
priestor bez výrazného vplyvu človeka.

4.	 Priemerný index tvaru polygónu (Mean Shape Index/MSI) – interakcia tvaru plôš-
ky a veľkosti môže ovplyvňovať rôzne ekologické procesy v krajinnej mozaike. Ak sa 
výsledná hodnota indexu blíži viac k nule, plôšky majú kruhový tvar. Hodnota MSI 
rastie s nepravidelnosťou tvarov plôšok.

5.	 Shannonov index diverzity (Shannon‘s Diversity Index/SHDI) – sa rovná nule za 
podmienky, že kategória krajinný prvok obsahuje len jednu plôšku. Hodnota SHDI 
rastie s počtom plôšok v kategóriách krajinných prvkov. Čím je hodnota indexu vyš-
šia, tým je väčšia heterogenita krajiny, t. j. krajina je bohatšia na počty kategórií kra-
jinných prvkov a počet plôšok.

6.	 Shannonov index rovnováhy (Shannon‘s Evenness Index/SHEI) – rovnováha je vy-
jadrená ako pozorovateľná úroveň diverzity (SHDI) delená maximálnym počtom 
kategórií krajinných prvkov. Úmerná redukcia počtu plôšok a kategórií zapríčiňuje 
aj zníženie celkovej rovnováhy. Čím je hodnota v sledovanom území bližšie k jednej, 
tým je lepšia rovnováha v krajinnej mozaike.
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6.4. Príklad aplikačného využitia krajinných metrík
Najčastejším príkladom využívania krajinných metrík je porovnávanie vývoja zmien 

krajinnej pokrývky za určité časové obdobia. Z oblasti geografie a krajinnej ekológie sa tejto 
problematike na Slovensku venuje viacero autorov, napr. Boltižiar (2003); Boltižiar (2010); 
Boltižiar a  Olah (2009); Ivanová, Michaeli a  Boltižiar (2013); Gajdoš, Klaučo a  Škodová 
(2012); Mojses a Boltižiar (2011); Olah, Boltižiar a Petrovič (2006); Oláhová, Vojtek a Bol-
tižiar (2012, 2013); Vojtek a Boltižiar (2010). Uvedení autori vo svojich prácach poukazujú 
na rôzne prístupy vo výskume vybraných vlastností krajiny. Tieto práce môžu slúžiť ako 
doplnkový študijný materiál, alebo ako východisková literatúra s obsahom praktických úloh 
a s názorným využitím softvérových operácií v reálnom výskume na Slovensku.

Pre potreby aplikačného využitia krajinných metrík je uvádzaný príklad analýzy zmien 
vývoja krajinnej štruktúry v modelovom území Štiavnické Bane (Banská Štiavnica) v rokoch 
1949, 1991 a 2008 (mapa 1).

6.4.1. Analýza priestorovej konfigurácie a krajinnej kompozície
Konfigurácia a kompozícia sú dominantné ukazovatele priestorových vlastností krajiny. 

Použitie indexov reprezentujúcich konfiguráciu alebo kompozíciu krajiny je však značne 
limitované, čo je spôsobené náročnou interpretáciou a identifikáciou ukazovateľov aj jed-
notlivo, ale najmä komplexne. Pritom relevantným cieľom v krajinnej ekológii nemusí byť 
vždy kvantifikácia priestorových ukazovateľov, mnohokrát zmysluplnejšie interpretácie po-
skytujú kvalitatívne ukazovatele (Miklós a Špinerová, 2010). Neuvážené a izolované použitie 
môže nebezpečne zjednodušovať komplexné procesy (Brandt, Holmes,1993). Krajinno-eko-
logická významnosť ukazovateľov konfigurácie a kompozície musí byť starostlivo prehodno-
tená alebo testovaná (Hobbs, 1997). 

Tabuľka 2  Analýza priestorovej konfigurácie – počet plôšok

Krajinná metrika Rok 1949 Rok 1991 Rok 2008
Rozdiel

´49 - ´91 ´91 - ´08 ´49 - ´08

Počet plôšok (NP) 330 366 314 36 -52 -16

Indexom sa vyjadruje celkový počet plôšok. Počet plôšok – krajinných prvkov – zvyšuje/znižuje heterogenitu 
a rozlíšenie krajinnej mozaiky. Najväčšia početnosť plôšok bola v roku 1991, kedy bola krajina na počet plôšok 
v jednotlivých kategóriách najviac diverzifikovaná, čo zároveň môže predstavovať aj najväčšiu fragmentáciu úze-
mia. 

Tabuľka 3  Analýza priestorovej konfigurácie – priemerná veľkosť plôšky

Krajinná metrika Rok 1949 Rok 1991 Rok 2008
Rozdiel

´49 - ´91 ´91 - ´08 ´49 - ´08
Priemerná veľkosť 
plôšky (MPS v ha) 7,1 7,1 6,2 0 -0,9 -0,9

Sledovaným indexom sa vyjadruje priemerná veľkosť plôšky. Postupná redukcia veľkosti plôšok smeruje ku frag-
mentácii krajinnej mozaiky. Sledované obdobie, ktoré má menšiu hodnotu MPS, je viac fragmentované. Index 
MPS má najväčšiu hodnotu v rokoch 1949 a 1991, ale zároveň analyzované územie obsahuje aj najväčší počet 
plôšok. V kombinácii indexov NP a MPS má krajinná mozaika v roku 1991 najväčšiu heterogenitu a zároveň 
najmenšiu fragmentáciu krajinných prvkov. 
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Mapa 1
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Tabuľka 4  Analýza priestorovej konfigurácie – štandardná veľkostná odchýlka

Krajinná metrika Rok 1949 Rok 1991 Rok 2008
Rozdiel

´49 - ´91 ´91 - ´08 ´49 - ´08
Štandardná veľkostná 
odchýlka (PSSD v ha) 15,1 11,9 12,1 -3,2 0,2 -3

PSSD index reprezentuje rozdiel veľkostí plôšok vo svojich kategóriách v rámci krajinnej mozaiky. Čím bližšie sú 
hodnoty k nule, tým viac majú zastúpené krajinné prvky podobnejšiu výmeru a krajina sa stáva homogénnejšou. 
Z uvedeného je možné konštatovať, že krajinné prvky v roku 1991 vykazujú najmenšie hodnoty. Zrejme je to 
v dôsledku politicko-hospodárskeho systému, ktorý pretrvával do roku 1989.

Tabuľka 5  Analýza priestorovej konfigurácie – priemerný index tvaru polygónu

Krajinná metrika Rok 1949 Rok 1991 Rok 2008
Rozdiel

´49 - ´91 ´91 - ´08 ´49 - ´08
Priemerný index tvaru 

polygónu (MSI) 1,89 1,97 2,16 0,08 0,19 0,27

Interakcia tvaru plôšky a veľkosti môže ovplyvňovať rôzne ekologické procesy v krajinnej mozaike. Ak sa výsled-
ná hodnota indexu blíži viac k nule, plôšky majú kruhový tvar. Hodnota MSI rastie s nepravidelnosťou tvarov 
plôšok. Najviac nepravidelný tvar vykazuje obdobie roku 2008, čo pri kombinácii indexu NP a MPS dokazuje 
najväčšiu fragmentáciu územia.

Tabuľka 6  Analýza krajinnej kompozície – Shannonov index diverzity

Krajinná metrika Rok 1949 Rok 1991 Rok 2008
Rozdiel

´49 - ´91 ´91 - ´08 ´49 - ´08
Shannonov index 
diverzity (SHDI) 1,31 1,41 1,33 0,1 -0,08 0,02

SHDI sa používa na výpočet diverzity jednotlivých tried, aj krajinnej mozaiky. SHDI sa rovná nule za podmienky, 
že kategória krajinný prvok obsahuje len jednu plôšku. Hodnota SHDI rastie s počtom plôšok v kategóriách kra-
jinných prvkov. Čím je hodnota indexu vyššia, tým je väčšia heterogenita krajiny, t. j. krajina je bohatšia na počty 
kategórií krajinných prvkov a na počet plôšok. Podľa výslednej sumy indexu je možné identifikovať, že krajina 
mala najväčšiu diverzitu v roku 1991.

Tabuľka 7  Analýza krajinnej kompozície – Shannonov index rovnováhy

Krajinná metrika Rok 1949 Rok 1991 Rok 2008
Rozdiel

´49 - ´91 ´91 - ´08 ´49 - ´08
Shannonov index 
rovnováhy (SHEI) 0,51 0,55 0,52 0,04 -0,03 0,01

Rovnováha je vyjadrená ako pozorovateľná úroveň diverzity (SHDI) delená maximálnym počtom kategórií kra-
jinných prvkov. Úmerná redukcia počtu plôšok a kategórií zapríčiňuje aj zníženie celkovej rovnováhy. Čím je 
hodnota v sledovanom území bližšia k jednej, tým je lepšia rovnováha v krajinnej mozaike. Rovnovážne zastú-
penie plôšok v kategóriách krajinnej mozaiky vykazuje rok 1991. Avšak rozdiely oproti ostatným rokom nie sú 
až tak výrazné.
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Tabuľka 8  Analýza krajinnej kompozície – index vzájomného susedstva

Krajinná metrika Rok 1949 Rok 1991 Rok 2008
Rozdiel

´49 - ´91 ´91 - ´08 ´49 - ´08
Index vzájomného 
susedstva (IJI/%) 64,41 69,55 66,89 5,14 -2,66 2,48

Výpočtom indexu sa plôšky vzájomne hodnotia z pohľadu susedstva s inou kategóriou krajinného prvku. Index 
nadobúda hodnoty v rozsahu 0 – 100, kde vyššia hodnota znamená väčšiu priestorovú variabilitu (premiešanie) 
krajinnej matrice. Vyššia hodnota čísla zároveň znamená rovnomernejšie susedské vzťahy s plôškami iného typu. 
Menšia hodnota znamená nerovnomerné rozmiestnenie plôšok. Za sledované časové obdobia je možné konštato-
vať, že IJI index je podobný, len s malými odchýlkami. Opätovne rok 1991 má najväčšiu hodnotu, t. j. priestorová 
distribúcia plôšok s inými kategóriami vykazovala v tomto období najlepšie hodnoty.

Výstup kvantifikácie zmien krajinných prvkov je možné zhrnúť do nasledovného záve-
ru. Najväčší počet plôšok bol v roku 1991 v spojení s priemernou veľkosťou plôšok (MPS). 
V období rokov 1949 a 1991 sú krajinné prvky najmenej fragmentované a vykazujú najväč-
šiu heterogenitu. Kombináciou uvedeného zistenia s ostatnými indexmi (SHDI, SHEI, IJI, 
PSSD a MSI) je možné konštatovať, že krajinné prvky boli v roku 1991 optimálne svojou 
priestorovou organizáciou a veľkosťou vzhľadom k výmere modelového územia.

6.4.2. Koeficient ekologickej stability
Ekologická stabilita je podľa Míchala (1994) chápaná ako koeficient ekologickej stability, 

resp. pomerové číslo, ktoré stanovuje pomer plôch tzv. stabilných a nestabilných krajino-
tvorných prvkov v skúmanom území. V tomto zmysle je možné konštatovať, že modelové 
územie v jednotlivých rokoch malo nasledovné hodnoty: rok 1949 = 12,48; rok 1991 = 8,65; 
rok 2008 = 8,39. Hodnoty za jednotlivé obdobia sú klasifikované nad prahovou úrovňou 
čísla ≥ 3, čo znamená, že modelové územie je prírodná a prírode blízka krajina s výraznou 
prevahou ekologicky stabilných prvkov a s nízkou intenzitou využívania krajiny človekom. 

6.4.3. Statické časti krajinnej pokrývky
Na základne analytických informácií o zmenách vo využívaní krajiny v rokoch 1949 – 

1991 – 2008 je možné priestorovo vyčleniť plochy, v ktorých nedošlo k substitúciám jednot-
livých kategórií krajinných prvkov. V modelovom území nedošlo k žiadnym zmenám na 
ploche o výmere 1407,83 ha, čo predstavuje 64 %. Na 36 % (786,96 ha) modelového územia 
došlo k zmenám (mapa 2). 

Otázky:

Čo je to krajinná štruktúra?1.	

Na akej úrovni sa uskutočňuje tzv. kvantifikácia krajinnej štruktúry?2.	

Aký je rozdiel medzi priestorovou konfiguráciou a krajinnou kompozíciou?3.	

Aký nástroj sa používa na tzv. kvantifikáciu krajinnej štruktúry?4.	

V akom kontexte, resp. oblasti, sa využívajú krajinné metriky?5.	
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Mapa 2
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Záver
Prostredie aplikácie ArcMap poskytuje profesionálne nástroje na prácu so spojitým dá-

tovým charakterom geografických informácií. K  najčastejšie používanému spojitému dá-
tovému typu patrí digitálny model terénu. Kapitola s názvom „Digitálny model terénu“ je 
zameraná na spektrum interpolačných algoritmov ako procesu výpočtu neznámych hodnôt 
určitého javu (nadmorskej výšky) na základe množiny známych hodnôt. Digitálny model 
terénu je možné v prostredí aplikácie ArcMap vytvoriť viacerými interpolačnými metóda-
mi. Priestor, ktorý nemá výškovú reprezentáciu, je dopĺňaný pomocou interpolačných alebo 
extrapolačných algoritmov. Funkcionalita nástrojov v prostredí aplikácie ArcMap je viazaná 
na rozšírenia Spatial Analyst, 3D Analyst a Geostatistical Analyst. 

Základné analýzy a interpretácie vlastností zemského povrchu sú obsiahnuté v kapitole 
s názvom „Analýza reliéfu“. Prostredie aplikácie ArcMap ponúka širokú bázu nástrojov na 
morfometrickú analýzu reliéfu, resp. kvantitatívny opis územia s  jeho čiastkovými terén-
nymi atribútmi. Výsledkom morfometrickej analýzy sú parametre a charakteristiky, ktoré 
smerujú k interpretácii vzťahu medzi reliéfom a jeho dynamikou, napr. pohyb vody a ma-
teriálu po povrchu. Medzi ďalšie parametre, ktoré sú výsledkom analýzy reliéfu, je možné 
zaradiť atribúty viditeľnosti a vzdialenosti. Z analýzy zmeny nadmorskej výšky sa uskutoč-
ňuje výpočet vzdialenosti potrebnej na presun materiálu, optimálne umiestnenie objektov 
vzhľadom k reliéfu alebo viditeľnosť určeného bodu.

Práca s priestorom, v ktorom sú body pospájané do 3D geometrického útvaru, je ob-
siahnutá v kapitole s názvom „3D zobrazenie geografických informácií“. Táto kapitola je za-
meraná na prácu s rozšírením 3D Analyst. Pomocou tohto rozšírenia sa posúva konvenčné 
dvojrozmerné zobrazenie geografických informácií do dynamického trojrozmerného po-
hľadu. Možnosť trojdimenzionálneho zobrazenia geografických informácií pomáha vizuali-
zovať rôzne prebiehajúce procesy v krajinnej sfére, generovať 3D pohľady, konštruovať rezy 
a priečne profily alebo počítať zmeny objemov 3D štruktúr nad alebo pod povrchom.

Základné hydrologické charakteristiky, akými sú smer prúdenia, práca s priehlbinami, 
resp. depresiami, tvorba siete vodných tokov a povodí atď., sa odvodzujú od analýzy reliéfu 
prostredníctvom  nástrojov rozšírenia Spatial Analyst. Prostredie ArcMap ponúka širokú 
bázu nástrojov (Spatial Analyst a záložka Hydrology) na analýzu rôznych parametrov via-
zaných k povrchovým vodám. Voda predstavuje jeden z najdôležitejších faktorov života na 
Zemi a v podmienkach Slovenska predstavuje hlavný modelačný činiteľ reliéfu.

Kapitola so zameraním na analýzu krajinnej štruktúry („Analýza krajinnej štruktúry“) 
prináša prehľad práce a  metodológiu kvantifikácie priestorovej konfigurácie a  krajinnej 
kompozície. Číselné hodnoty ako výpočty z  krajinných metrík tvoria podklad účelových 
interpretácií prebiehajúcich ekologických procesov v  krajine. Pomocou analýz krajinnej 
štruktúry, najmä analýz zmien krajinnej pokrývky, je možné vyvodiť (interpretovať) vybra-
né spektrum základných kvalitatívnych ukazovateľov, napr. ekologickú významnosť krajiny. 
Kapitola je doplnená o príklad aplikačného použitia vo vybranom modelovom území.
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Priestorová konfigurácia,�  56
Priestorové analýzy,�  6, 7
prúdenie,�  47

R
Raster Calculator,�  31, 50, 71
Raster To Polyline,�  52
Raster to TIN,�  40, 71
Reclassify,�  24, 25, 36, 50, 71
Relatívna výška terénu,�  22
Reliéf,�  8, 47, 68, 80

S
Scene,�  44, 45, 46, 71
Shannonov index diverzity,�  60, 63, 72
Shannonov index rovnováhy,�  60, 63, 72
Shannon‘s Diversity Index,�  60
Shannon‘s Evenness Index,�  60
Sieť vodných tokov,�  50
Sink,�  19, 20, 48, 49, 71
Sklon reliéfu,�  22, 24
Slope,�  24, 70
Smer prúdenia,�  47
Snap Pour Point,�  54
Spatial Analyst,�  7, 8, 14, 15, 16, 17, 18, 

23, 24, 25, 26, 27, 28, 31, 32, 34, 
36, 47, 48, 49, 50, 51, 52, 53, 54, 
57, 66, 72

Spline,�  12, 13, 15, 16, 70
Stream Link,�  51, 72
Stream Order,�  51, 72
Stream to Feature,�  52, 72
Surface,�  7, 8, 23, 24, 26, 32, 34, 36

Š
Štandardná veľkostná odchýlka,�  60, 63

T
TIN to Raster,�  41, 71
Topo to Raster,�  13, 18, 70
Trend,�  12, 16, 70

V
Vertikálna krivosť reliéfu,�  70
Viewshed,�  32, 71

W
Watershed,�  53, 54, 72
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Príloha 1  Online GIS (bezplatné) mapové služby
GIS online mapové služby sú geografické informačné služby, ktoré sú prístupné na webe 

pomocou štandardných technológií a protokolov. V posledných rokoch sa rapídne rozširu-
jú buď prostredníctvom nadšencov geopriestorových dát, alebo oficiálne prostredníctvom 
štátnych inštitúcií, ktoré verejnosti otvárajú svoje databázy. Mapové služby sú najobvyklej-
ším spôsobom publikovania GIS dát a vytvárania tzv. mashups (prepojených sád mapových 
služieb v spoločnej online mape). Tak ako všetky webové služby, sú aj GIS mapové služby 
zamerané na sadu GIS funkcií a využívajú otvorené webové protokoly, napr. XML, SOAP 
a služby REST web a HTML. 

Open Geospatial Consortium (OGS) služby poskytujú rad štandardných webových slu-
žieb, vrátane Web Map Service (WMS), Web Feature Service (WFS) a Web Coverage Service 
(WCS). WMS služba pracuje na princípe klient-server a umožňuje zdieľanie priestorových 
údajov vo forme rastrových máp. Výstupom sú georeferencované rastrové údaje vo formáte 
JPEG, PNG, TIFF a pod., ktoré buď zobrazujú určité vrstvy, alebo sú výsledkom mapovej 
kompozície. Podobne aj ukladacia služba WFS pracuje na princípe klient-server a umožňu-
je zdieľanie priestorových údajov v podobe vektorového kódu v jazyku GML (XML). WCS 
služba poskytuje coverage údaje, najčastejšie vo formáte GeoTIFF, NITF, HDF.

Mapový server ArcIMS je online služba firmy ESRI, ktorá umožňuje centrálne prezento-
vať a poskytovať mapy, dáta GIS a služby. Výsledkom požiadavky klienta sú obrazové geore-
ferencované dáta s atribútovými údajmi. V súčasnosti je táto služba nahradená technológiou 
ArcGIS Server. ArcGIS online (arcgis.com) odkazuje na on-line schopnosti celého systému 
ArcGIS. 

KML (Keyhole Markup Language) je jazyk založený na XML, poskytovaný spoločnosťou 
Google na definovanie grafického zobrazenia priestorových dát v aplikáciách Google Earth 
a Google Maps. ArcGIS užívatelia môžu publikovať mapu ako KML pomocou ArcGIS pre 
server. 

Prehľad najčastejšie používaných online mapových služieb na Slovensku

Názov služby Typ služby Adresa

Geologický portál WMS/WebGIS http://www.geology.sk

Mapový server ŠGÚDŠ je miesto, kde môžete nájsť priestorové informácie o geológii. Je určený nielen pre odbor-
níkov, ale aj pre širokú verejnosť. Technické riešenie je založené na technológii ArcGIS Server spoločnosti ESRI. 
Mapový server ponúka dva prístupy k priestorovým údajom. Sú to mapové aplikácie a WMS služby.

Geoportál WMS/WFS/WCS/WebGIS http://www.geoportal.sk

ÚGKK SR zabezpečuje sprístupnenie referenčných priestorových údajov na národnej úrovni. Údaje sú sprístup-
nené mapovými službami, ktoré sú publikované podľa OGC štandardov (WMS, WFS, WCS).

Pôdne mapy WebGIS http://www.podnemapy.sk

Informačný systém Výskumného ústavu pôdoznalectva a ochrany pôdy (VÚPOP) prostredníctvom internetu 
a mapového servera umožňuje širokej verejnosti prezerať informácie o poľnohospodárskej pôde.

Slovenský mapový portál WebGIS, WFS http://mapy.atlas.sk

Mapový portál spoločností Eurosense s.r.o., Geodis Slovakia s.r.o. a Mapa Slovakia Digital, s.r.o. ponúka prehľad-
né vektorové mapy a ortofotomapy.
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Atlas krajiny SR WebGIS http://geo.enviroportal.sk/atlassr

Súbor mapových kompozícií ilustrujúcich pôvodné prírodné pomery a vplyv ľudskej činnosti na vývoj slovenskej 
krajiny v čase prostredníctvom samostatných tematických mapových zobrazení.

Informačný systém env. 
záťaže WebGIS http://geo.enviroportal.sk/env_zataze

Aplikácia umožňuje prostredníctvom zadania environmentálnej záťaže alebo na základe územnosprávneho čle-
nenia a interaktívnej mapy zobraziť lokalitu na podkladovej mape SVM50, vrátane detailného popisu konkrétnej 
environmentálnej záťaže.

Corine Land Cover WebGIS http://geo.enviroportal.sk/corine

Projekt Land Cover Corine (LCC) mapovania povrchu Európy zo satelitov LANDSAT.

NATURA 2000 - Územia 
európskeho významu WebGIS http://geo.enviroportal.sk/uev

Webmapová aplikácia publikujúca údaje patriace pod Národný zoznam navrhovaných území európskeho význa-
mu, ktorá umožňuje prostredníctvom listboxov a interaktívnej mapy vyhľadať a následne zobraziť lokalitu resp. 
hranice konkrétneho chráneného územia európskeho významu.

Hiking.sk WebGIS http://mapy.hiking.sk

Podrobné turistické mapy celého Slovenska v mierke 1:25 000. Okrem topografických máp a podkladu SHOcart 
obsahuje satelitné snímky a podrobné mapy lavínových dráh.

Freemap Slovakia.sk WebGIS http://www.freemap.sk/

Mapy vychádzajúce z filozofie OSM vrátane detailných turistických a cyklistických vrstiev z  celého Slovenska 
(OSM exporty sú prístupné pre Garmin a mnohé ďalšie GPS zariadenia).

Prehľad najčastejšie používaných online mapových služieb v zahraničí

Názov služby Typ služby Adresa

Google Maps WebGIS, KML https://maps.google.com/

Google ponúka posúvateľné mapy a satelitné snímky celého sveta a plánovač ciest s vyhľadávaním a lokalizova-
ním firiem a ďalších objektov.

Open Street Map WebGIS, SHP http://www.openstreetmap.org/

Projekt zastrešený neziskovou organizáciou Open Street Map Foundation, na ktorom sa podieľajú komunity kar-
tografických nadšencov z celého sveta. OSM dáta sú bezplatne zdieľané v rámci licencie pod podmienkou, že 
akékoľvek dáta vytvorené v OSM sú prístupné pre ostatných užívateľov.

Wikimapia WebGIS, KML http://wikimapia.org/

Wikimapia je multinárodná kolaboratívna mapa, kde každý môže vytvárať miestne záložky a zdieľať geograficky 
viazané lokálne poznatky s cieľom popísať svet prostredníctvom čo najviac užitočných geografických informácií 
s voľne prístupnou verejnou doménou.

Barnabu WebGIS, KML http://www.barnabu.co.uk/

Barnabu ponúka široké spektrum Google Earth add-ons, vizualizácie vrátane letových máp, animácií, hviezd 
a planét a pod.

Flight Radar24 WebGIS, KML http://www.flightradar24.com/

Flight Radar24 je služba sledovania letov, ktorá prostredníctvom ADS-B prijímačov poskytuje informácie o tisíc-
kach letov v reálnom čase po celom svete.

Natural Earth - world 
maps SHP http://www.naturalearthdata.com/

Excelentný zdroj svetových SHP máp so štátnymi a  administratívnymi hranicami, pobrežím, osídlením atď. 
v rôznych mierkach.
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Map Library SHP, KML www.maplibrary.org

SHP mapy krajín Afriky vrátane hraníc, administratívneho členenia a satelitných snímok stiahnuteľné vo via-
cerých formátoch.

Geocommons SHP http://geocommons.com/

Obsiahla databáza stiahnuteľných máp rôzneho zamerania z celého sveta, vrátane Slovenska, poskytnutá použí-
vateľmi.

Maptell SHP http://www.maptell.com/

Maptell je voľne prístupný digitálny repozitár niektorých svetových GIS vrstiev a máp.

World Bank SHP, WebGIS http://maps.worldbank.org/

Projekt, ktorý vizualizuje lokality financované Svetovou bankou na zlepšenie efektivity koordinácie financovania 
a transparentnosti.

MapCruzin SHP http://www.mapcruzin.com/

Vynikajúci zdroj širokého spektra SHP súborov prevažne z USA.

United Nations SHP http://www.unsalb.org/

Dataset projektu UN-SALB (Second Administrative Level Boundaries), overený národnými mapovacími agen-
túrami každého UN štátu.

USGS KML files KML http://earthquake.usgs.gov/learn/kml.php

Portál USGS (United States Geological Survey) poskytujúci dáta k sopečným erupciám, zemetraseniam, poru-
chám a povodniam, zosuvom z LiDAR a pod. pre Google Earth.

OneGeology Portal WebGIS, WMC, KML http://portal.onegeology.org/

OneGeology je medzinárodný projekt geologických výskumov sveta a vďaka nadšencom geológie ponúka voľne 
prístupné dynamické geologické dáta.

Portál informačného sys-
tému ochrany prírody WebGIS, ArcGIS http://portal.nature.cz

Informačný systém ochrany prírody (ISOP) zabezpečuje prístup k dátam buď technológiou klient/server ArcSDE 
(ESRI) alebo prostredníctvom jednotlivých webových aplikácií.

Mapy.cz WebGIS http://mapy.cz/

Portál Mapy.cz obsahuje podrobné vektorové, topografické, turistické mapy a ortofotomapy celého územia ČR.

Mapový server Českej 
geologickej služby WebGIS, WMS http://www.geology.cz/

Mapový server ČGS sprístupňuje široké spektrum priebežne aktualizovaných máp, aplikovaných dát a informá-
cií.
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Príloha 2  Online GIS (bezplatné) časopisy
ArcWatch od vydavateľa ESRI je určený ako GIS nováčikom, tak i skúseným profesioná-

lom. Prináša novinky zo sveta GIS technológií v podobe prípadových štúdií, technických tipov 
k ESRI softvéru, rozhovorov s najväčšími lídrami GIS, kartografických rád, podujatí, publiká-
cií a noviniek zo sveta produktov. Viac na: http://www.esri.com/esri-news/arcwatch.

Directions Magazine je prvým pravidelne publikujúcim online časopisom z  oblasti 
GIS a  geopriestorovej technológie. Vydavateľ Directions Media je považovaný za hlavný 
zdroj geopriestorových informácií z celého sveta, trendov v technológii, aktuálnych otázok 
prostredníctvom spravodajov, podcastu, blogov, webových kanálov a webinárov, vrátane ak-
tuálnych komentárov: http://www.directionsmag.com.

GeoBusiness z  vydavateľstva Springwinter, s.r.o. vychádza od roku 2002. Na svojich 
stránkach http://www.geobusiness.cz ponúka novinky a zaujímavosti zo sveta geoinforma-
tiky, geodézie, kartografie, katastra nehnuteľností a pozemkových úprav pre firmy aj jednot-
livcov. 

GeoConnexion patrí medzi najlepšie etablované periodiká GIS priemyslu. Funguje už 
22 rokov a je vydávaný spoločnosťou Mal Ward, pričom ponúka spektrum tém, z ktorých 
najpopulárnejšie sú LiDAR, Mobilné GIS, Otvorené GIS, Remote Sensing, 3D vizualizácia, 
GMES, GNSS, INSPIRE, laserové skenovanie, Web mapovanie a sociálne siete: http://www.
geoconnexion.com.

GISCafe.com je portál, ktorý ponúka GIS špecialistom kompletné katalógové zoznamy 
GIS produktov, technické články, GIS novinky, rozhovory s generálnymi riaditeľmi, multi-
mediálne prezentácie, prioritné tlačové správy, oznamy o aktuálnom dianí, ponuky práce 
a pod. Portál prináša týždenný výber noviniek GISWeekly Review. 

GPS World pokrýva tematiku odboru GPS od roku 1989, online od roku 1998 vo forme 
interaktívnych mikrostránok členených podľa odboru, s informáciami o najčerstvejších ná-
strojoch pre profesionálov z každej technickej oblasti, ktorá využíva GPS, navigáciu a časo-
vanie, vrátane najnovších obsiahlych GPS/GNSS noviniek pre inžinierskych a projektových 
manažérov, vedcov a systémových vývojárov na adrese: www.gpsworld.com. 

Point of Beginning pomáha profesionálom z oblasti geodézie a geomatiky zdokonaľovať 
sa štúdiom informácií o nových technológiách a možnostiach. Ponúka praktické riešenia 
problémov pri pozemnom zameriavaní a mapovaní, pričom poskytuje novinky aj zo sveta 
firemných stratégií, legislatívy a vzdelania. Viac na stránkach http://www.pobonline.com.

Geospatial World vydávaný Gospatial Development je zdrojový portál najnovších ge-
opriestorových informácií. Portál je najstarším a najväčším vo svete vôbec a  funguje ako 
interaktívne médium medzi GIS profesionálmi vo viac než 150 krajinách. Výber toho naj-
lepšieho ponúka Geospatial World Weekly: www.geospatialworld.net.

GISuser poskytuje informácie o vývoji, analýzach a správach týkajúcich sa používateľov 
GIS a príbuzných geopriestorových technológií. Viac na: http://www.gisuser.com.

GeoCommunity je obsiahly informačný portál prevádzkovaný MindSites Group, kto-
rý okrem noviniek zo sveta GIS ponúka aj diskusnú platformu pre užívateľov a informácie 
o nových pracovných a obchodných príležitostiach a akciách: http://spatialnews.geocomm.
com.
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Príloha 3  Základný GIS slovník
ArcCatalog – aplikácia určená na správu geografických informácií, ide o  tzv. manažé-
ra priestorových informácií. ArcCatalog spravuje geografické informácie v  adresárovom 
priestore alebo v geodatabázach.

ArcGIS – komplexné GIS softvérové riešenie od spoločnosti ESRI, resp. softvérový systém, 
ktorý umožňuje používateľom zhromažďovať, organizovať, riadiť, analyzovať a distribuovať 
geografické informácie. Ide o poprednú svetovú platformu práce s GIS. Systém je k dispozí-
cii vo forme on-line internetových aplikácií, produktov pre mobilné telefóny resp. smartfó-
ny, servery a osobné počítače. ArcGIS je tvorený sériou rôznych produktov prepojených do 
jedného pracovného prostredia.

ArcGlobe – modul programu ArcGis (rozšírenie 3D Analyst), ktorý slúži na zobrazovanie 
priestorovo orientovaných údajov na povrchu 3D zemegule, glóbusu. 

ArcIMS – software spoločnosti ESRI umožňujúci spravovať a obsluhovať mapy, dáta a apliká-
cie, ktoré budú použité na internete. Administratívny rámec umožňuje používať súbory autor-
skej konfigurácie, publikovať mapy, tvoriť internetové stránky a spravovať ArcIMS servery. 

ArcMap – GIS aplikácia so zameraním na vytváranie geografických informácií, tvorbu máp, 
prácu s databázovým rozhraním, priestorovými informáciami atď.

ArcScene – modul programu ArcGis (rozšírenie 3D Analyst), ktorý umožňuje tvorbu 3D 
údajov, ich analýzu, zobrazovanie a prezentáciu v podobe 3D modelov pri použití rôznych 
3D efektov (pohľad zo všetkých strán, priehľadnosť, osvetlenie a pod.).

ArcToolBox – užívateľské rozhranie v prostredí programu ArcGis zahŕňajúce súbor geopro-
cesingových nástrojov, modelov a skriptov, ktoré slúžia na prácu s priestorovými dátami.

CAD – (skratka pre computer-aided design – počítačom podporované navrhovanie) počí-
tačový systém (aplikácia) na navrhovanie, projektovanie a zobrazenie grafických informácií. 
CAD aplikácie používajú grafické, geometrické i matematické nástroje na tvorbu plošných 
náčrtov a modelovanie objektov reálneho sveta. 

Cloud – názov vychádza z anglického oblak, mrak, mračno. Mračno v podstate predstavuje 
zhluk hardvérových a softvérových výpočtových prostriedkov (napr. programov, služieb), kto-
ré sú využívané prostredníctvom internetu (siete) a pre koncového užívateľa nie sú viditeľné. 

DTM – zdigitalizovaný trojrozmerný obraz zemského povrchu. Každému zobrazenému 
bodu sú priradené informácie, ktoré určujú jeho polohu a nadmorskú výšku. 

EPSG – databáza parametrov používaná na identifikáciu súradnicového systému a na defi-
novanie transformácií a konverzií medzi referenčnými súradnicovými systémami (súradnice 
istého bodu z jedného systému sa prevedú na súradnice iného systému). Databázu vytvorila 
European Petroleum Survey Group (EPSG) v roku 1985.

Fotogrametria – súbor metód slúžiacich na získavanie súradníc jednotlivých objektov 
prostredníctvom analógových alebo digitálnych fotografií (leteckých snímok a diaľkového 
prieskumu Zeme). 

Geodézia – vedný odbor zaoberajúci sa určovaním tvaru a rozmerov zemského telesa a jeho 
zobrazením. Zároveň sa venuje štúdiu gravitačného a magnetického poľa Zeme, slapových 
javov a geologickým pohybom zemskej kôry.
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Geoinformatika – vedná disciplína, ktorá sa zameriava na vývoj a aplikáciu metód na rie-
šenie úloh v geografických vedách so špeciálnym dôrazom na geografickú polohu (vzájom-
né priestorové vzťahy objektov). Sústreďuje sa na zber, uloženie a distribúciu geografických 
dát a umožňuje ich vizualizáciu a priestorové analýzy. Pomocou počítačového modelovania 
skúma prírodné a socio-ekonomické geosystémy, ich štruktúru, interakcie a dynamiku. 

Geografia – vedná disciplína, resp. súbor vedných disciplín, ktoré skúmajú krajinnú sféru 
a vzťahy medzi systémom prírodného prostredia a systémom ľudskej spoločnosti v priestore 
a čase. Vedná disciplína vznikla zo snahy preskúmať a opísať Zem za účelom zlepšenia vyu-
žívania prírodných zdrojov a optimálneho rozmiestnenia činností ľudskej spoločnosti. 

Geografické informácie – geografické údaje spracované v  prostredí GIS. Ide o  informácie 
transformované do digitálnej podoby, ktoré priamo alebo nepriamo súvisia s miestom prira-
deným k zemskému povrchu alebo jeho blízkosti. Každá takáto informácia má svoje geomet-
rické, geografické a databázové rozhranie, s ktorým je možné v prostredí GIS ďalej pracovať. 

Geografické údaje – údaje o objektoch a vzťahoch s konkrétnou polohou v reálnom sveto-
vom priestore, t. j. údaje týkajúce sa zemského povrchu alebo jeho blízkosti.

Geomatika – veda zaoberajúca sa zberom geografických dát prostredníctvom rôznych 
spôsobov meraní, ich prvotným spracovaním, analýzou, distribúciou a prezentáciou. Ge-
ografické dáta môžu mať rôznu podobu a formát: mapa, databáza, vrstva, štatistický súbor, 
letecká snímka. 

Geoprocesing – sumárne označenie operácií slúžiacich na manipuláciu s priestorovými dá-
tami. Typická geoprocesingová operácia zahŕňa analýzu vstupného dátového súboru, vyko-
nanie operácie v tomto súbore a tvorbu výsledku operácie v podobe výstupných dátových 
súborov.

Georeliéf/reliéf – súbor vypuklých a vydutých tvarov na povrchu Zeme – na súšach i dnách 
oceánov a morí. Pôsobením vnútorných a vonkajších geologických činiteľov na reliéfe vzni-
kajú rôzne tvary. Reliéf je v neustálom vývoji. Na mapách je znázornený obrysmi, tieňova-
ním, hypsometriou a pod. 

Geoštatistika – druh štatistiky používaný na analýzu a  predikciu hodnôt spojených 
s priestorovými alebo časopriestorovými javmi. Geoštatistické metódy slúžia na modelova-
nie prostredníctvom využitia priestorových informácií a údajov.

Geoúdaj – označenie pre geografický, priestorový údaj. Je to vlastne údaj s implicitným a ex-
plicitným vzťahom k zemskému povrchu alebo k jeho blízkosti. 

GIS – geografické informačné systémy predstavujú typ informačných systémov, ktoré sú 
určené na zachytávanie, ukladanie, vyhľadávanie, analýzu a  zobrazovanie priestorových 
údajov.

GPL/GNU – GNU – projekt spustený v  roku 1984, ktorý pod licenciou (GPL – general 
public license) vedie voľný softvér (free software) zaručujúci koncovému užívateľovi (jed-
notlivec, organizácia) slobodu spočívajúcu v spúšťaní, kopírovaní, distribuovaní, študovaní, 
upravovaní a vylepšovaní tohto softvéru. 

GPS – (skratka pre Global Positioning system – globálny lokalizačný systém) je satelitný 
navigačný systém používaný na zistenie presnej pozície bodu prostredníctvom signálu vy-
sielaného z družíc a prijímaného GPS prístrojom. Systém je využívaný najmä v navigácii 
a pri tvorbe máp.
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HTML – skratka (akronym) pre Hypertext Markup Language – hypertextový značkovací 
jazyk. Predstavuje značkovací jazyk používaný na vytvorenie webovej stránky určenej na 
publikovanie prostredníctvom internetu. Je to vlastne systém značiek, ktoré definujú funkcie 
textu, grafiku, zvuk a videá v rámci dokumentu. Špecifikáciu jazyka HTML spravuje World 
Wide Web Consortium.

http – skratka (akronym) pre Hypertext Transfer Protocol – hypertextový prenosový proto-
kol. Predstavuje protokol v správe World Wide Web Consortia na prenos html dokumentov 
medzi servermi a klientmi cez internet.

IP Adresa – skratka (akronym) pre adresu internetového protokolu. Predstavuje jedinečné 
číslo, ktoré identifikuje každý uzol (počítač) v sieti internetu. Je podobné telefónnemu číslu, 
zapisuje sa v desiatkovej sústave a súbory čísel sú oddelené bodkou. IP adresy umožňujú 
prenášať dáta medzi jednotlivými počítačmi navzájom cez internet.

JPEG – štandardná metóda stratovej kompresie obrázkov (fotografií) vo formáte bežne po-
užívanom na publikovanie na internete. Formát je vhodný na prenášanie a ukladanie obráz-
kov, ktoré obsahujú spektrum farieb. Skratka znamená Joint Photographic Experts Group, 
čo je názov konzorcia, ktoré kompresiu navrhlo.

Kartografia – veda zaoberajúca sa zostavovaním máp o polohe objektov a javov nachádzajú-
cich sa na zemskom povrchu, na dne morí a oceánov alebo kdekoľvek v kozme.

Kartografické dielo – mapa, mapová schéma, atlas, glóbus, digitálny obraz reality. Vzniká 
ako výsledok kartografického znázornenia objektov a javov na Zemi (i vzťahov medzi nimi), 
Zeme samotnej alebo kozmických telies spolu s textovými a obrazovými doplnkami.

Krajinná sféra – najväčší geosystém tvorený sústavou navzájom sa prelínajúcich obalov, 
obklopujúcich celé zemské teleso. Krajinnú sféru tvoria dve základné časti: fyzicko-geogra-
fická sféra prírodného pôvodu a socio-ekonomická sféra vytvorená človekom. Navzájom sú 
spojené vzťahmi a väzbami.

Local area network (LAN) – v informatike lokálna počítačová sieť, spájajúca počítače a ďal-
šie zariadenia, pokrývajúca menšiu geografickú oblasť (do niekoľko km), ako napríklad 
dom, kancelária alebo skupina budov. Súčasné LAN bývajú najčastejšie založené na prepí-
naných ethernetových sieťach, s prepojením metalickým káblom, optickým káblom, alebo 
bezdrôtovo (Wi-Fi, WiMAX, Bluetooth, Irda).

Mapa – zjednodušené zobrazenie Zeme, kozmu, kozmických telies a ich častí do roviny, príp. 
na iný geometrický útvar, napr. glóbus. Mapa graficky znázorňuje objekty a javy nachádzajú-
ce sa v určitom priestore. Vyhotovuje sa pomocou kartografických zobrazení a definované-
ho pomeru zmenšenia objektov na mape voči skutočnosti. Slúži ako navigačná pomôcka.

Mapové dielo – mapa resp. súbor mapových listov súvislo zobrazujúcich územie, vyhoto-
vených podľa jednotných zásad (mierka, kartografické zobrazenie, jednotný všeobecne vy-
užiteľný obsah). 

Mapový znak – dohovorený (ustálený) mapový symbol slúžiaci na znázornenie polohy, dru-
hu a kvalitatívnej i kvantitatívnej charakteristiky objektov a javov v mape. Môže mať bodový, 
líniový či plošný tvar alebo tvar diagramu. 

Priestorový údaj – akýkoľvek údaj, ktorý sa vzťahuje ku konkrétnemu miestu na zemskom 
povrchu alebo v jeho blízkom okolí, kde na určitej rozlišovacej úrovni je známa aj geogra-
fická poloha. 
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Raster – typ dátového formátu, v ktorom sú geografické údaje (prvky a objekty reálneho 
sveta) abstrahované (zaznamenané) prostredníctvom siete buniek pozostávajúcej z riadkov 
a stĺpcov. Každá bunka má štvorcový tvar a atribútovú hodnotu v podobe čísla. 

RAW – (z anglického raw – surový, nespracovaný) je obrazový formát obsahujúci len mini-
málne spracované dáta zo snímača digitálneho fotoaparátu.

Script – časť programu alebo program samotný, zapísaný v podobe kódu a obyčajne uložený 
ako súbor. Jeho funkcia spočíva vo vykonávaní určitej úlohy, na splnenie ktorej bol vytvore-
ný a naprogramovaný.

Server – môže mať podobu počítača (hardvéru), ale aj softvéru. Prostredníctvom neho si 
môžu jednotlivé počítače v sieti vymieňať dáta, môžu používať dáta, ktoré sú na ňom ulože-
né, príp. ho môžu použiť ako bránu na vstup do inej siete.

SQL – (skratka pre Structured Query Language – štruktúrovaný opytovací jazyk) je počí-
tačový jazyk na manipuláciu a definíciu dát. V súčasnosti je najpoužívanejším jazykom vo 
väčšine relačných databázových systémov. 

TIF – (skratka pre Tagged Image File) súborový formát slúžiaci na ukladanie rastrovej počí-
tačovej grafiky. Formát nesie grafické informácie, ktoré sú zaznamenané v podobe pixelov. 

Vektor – typ dátového formátu, v ktorom sú geografické údaje (prvky a objekty reálneho 
sveta) zaznamenané prostredníctvom troch základných geometrických útvarov – bod, línia, 
polygón. Údaje samotné si nesú informáciu o svojej geografickej polohe, geometrickej inter-
pretácii a základnej charakteristike v podobe atribútov. 

WebGIS – základná technológia analýzy, tvorby a  publikovania konkrétnych geodát 
prostredníctvom internetu. Často sa zamieňa za pojem web mapping, čo však znamená na-
vrhovanie, tvorbu a poskytovanie výsledných máp prostredníctvom internetu.

WGS 84 – (skratka pre World geodetic system – svetový geodetický systém) najpoužívanejší 
geodetický štandard vydaný ministerstvom obrany USA v roku 1984, ktorý definuje súrad-
nicový systém využívaný v geodézii, navigácii a pri tvorbe máp. Tento súradnicový systém 
používajú aj GPS zariadenia.

Wide Area Network (WAN) – v informatike počítačová sieť, ktorá pokrýva rozľahlé geogra-
fické územia (napríklad sieť, ktorá prekračuje hranice mesta, regiónu alebo štátu). Najväč-
ším a najznámejším príkladom siete WAN je internet. Siete WAN sú využívané na spojenie 
lokálnych sietí (LAN) alebo ďalších typov sietí, takže užívatelia z jedného miesta môžu ko-
munikovať s užívateľmi a počítačmi na inom mieste. 
XML – (skratka pre Extensible Markup Language) štandardizovaný všeobecný značkovací 
jazyk vyvinutý World Wide Web konzorciom, ktorý uľahčuje výmenu dát medzi počítačo-
vými aplikáciami a zverejňovanie dokumentov.
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Príloha 4  Používané skratky v oblasti GIS
AGI 		  Association for Geographic Information

AGILE 		  Association of Geographic Information Laboratories in Europe

API 		  Application programming interface

ASCII 		  American Standard Code for Information Interchange

BLOB		  Binary large object

CAD 		  Computer-Aided Design

CGIS		  Canada Geographic Information System

DBMS 		  Database management system

DCM 		  Digital cartographic model

DEM 		  Digital elevation model

DGPS 		  Differential Global Positioning System

DLM 		  Digital landscape model

DTM		  Digital terrain model

DXF 		  Drawing exchange format

ERDAS 		  Earth Resource Data Analysis System

ESRI		  Environmental Systems Research Institute

GML 		  Geography Markup Language

GNIS 		  Geographic Names Information System

GNSS		  Global Navigation Satellite System

GPS		  Global Positioning System

GRASS 		  Geographic Resources Analysis Support System

GUI 		  Graphical user interface

IMW 		  International Map of the World

INSPIRE 	 Infrastructure for Spatial Information in Europe

ISCGM 		 International Steering Committee for Global Mapping

LiDAR 		  Light detection and ranging

LMIS 		  Land Management Information System 

MBR 		  Minimum bounding rectangle 

MrSID 		  Multiresolution Seamless Image Database 

MSC 		  Mapping Science Committee

NASA 		  National Aeronautics and Space Administration

NCGIA 		 National Center for Geographic Information and Analysis

NGA 		  National Geospatial-Intelligence Agency
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NSDI 		  National Spatial Data Infrastructure

ODBMS 	 Object database management systém

OEM 		  Office of Emergency Management

OGC 		  Open Geospatial Consortium

OLM 		  Object-level metadata

OLS 		  Ordinary least squares

ONC 		  Operational Navigation Chart

ORDBMS 	 Object-relational database management syste

PDA 		  Personal digital assistant

PE 		  Photogrammetric engineering

PLSS 		  Public Land Survey System

PPGIS 		  Public participation in GIS

RDBMS 		 Relational database management system

RFP 		  Request for Proposals ň

RGB 		  Red Green Blue

RMSE 		  Root Mean Square Error

RS 		  Remote Sensing

SAP 		  Spatially aware professional

SDE 		  Spatial Database Engine

SDI 		  Spatial Data Infrastructure

SDSS 		  Spatial Decision Support Systems

SPC 		  State Plane Coordinates

SPOT 		  Syste`me Probatoire d’Observation de la Terre

SQL 		  Structured/Standard Query Language

TIN 		  Triangulated Irregular Network

TOID 		  Topographic Identifier

UCGIS 		  University Consortium for Geographic Informa- tion Science

UDDI 		  Universal Description, Discovery, and Integration

UML 		  Unified Modeling Language

UNIGIS 		 UNIversity GIS Consortium

UPS 		  Universal Polar Stereographic

URISA 		  Urban and Regional Information Systems Association

USGS 		  United States Geological Survey 

UTM 		  Universal Transverse Mercator 
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Príloha 5  Katalóg mapových zostáv
Mapa je zjednodušené zobrazenie Zeme, kozmu, kozmických telies a ich častí do roviny, 

prípadne na iný geometrický útvar, napr. glóbus. Mapa graficky znázorňuje objekty a javy 
nachádzajúce sa v určitom priestore. Vyhotovuje sa pomocou tzv. kartografických zobrazení 
a definovaného pomeru zmenšenia objektov na mape voči skutočnosti. Slúži ako navigač-
ná pomôcka, ktorá vyjadruje vzťahy medzi objektmi v priestore, ako sú napr. poloha, veľ
kosť, vzdialenosť, uhol atď. Každá mapa sa skladá z určitých komponentov, ktoré majú svoj 
význam:

Názov mapy1.	  vyjadruje obsahové zameranie, priestorové vymedzenie územia, prí-
padne účel, na aký bola vytvorená. V niektorých prípadoch sa k názvu pridáva aj 
časové obdobie.

Geografická sieť2.	  je druh súradnicovej siete (existujú aj iné druhy súradnicových 
sietí). Ide o sústavu čiar (poludníkov a rovnobežiek) v mapovom poli, spájajúcich 
miesta s rovnakými geografickými súradnicami (geografická šírka a dĺžka).

Vysvetlivky (legenda)3.	  poskytujú „kľúč“ k pochopeniu použitých mapových znakov. 
Pri rozsiahlych mapových dielach bývajú vysvetlivky ako samostatná knižná publi-
kácia, napr. topografické alebo geologické mapy.

Tiráž4.	  obsahuje informácie o autorovi, vydavateľovi, roku vydania mapy, autorských 
právach.

Mapový znak5.	  je grafický symbol mapového vyjadrenia, ktorý určuje význam a po-
lohu prvkov na mapovom podklade. Mapovým znakom je krúžok alebo obdĺžnik 
(grafický symbol), ktorý reprezentuje napr. sídlo a svojou geografickou polohou je 
lokalizovaný na mape. Význam mapového znaku je spravidla vysvetlený v legende, 
avšak nie je to pravidlom.

Vrstva mapy6.	  je grafické zoskupenie mapových znakov s  rovnakým významom, 
napr. vrstva názvov miest, vrstva vodných tokov, vrstva administratívneho členenia 
Slovenska na územné celky atď.

Pole mapy (mapové pole)7.	  je plocha vlastnej mapy bez plôch obsadených vysvetliv-
kami, mierkou, orientačnou šípkou, tirážou atď.

Mapový podklad8.	  je vo väčšine prípadov topografická mapa zobrazujúca výškopis-
né a  polohopisné prvky. Medzi výškopisné prvky patria vrstevnice, výškové kóty, 
výškové body alebo tieňovanie reliéfu. Popis mapy je súbor všetkých geografických 
názvov, skratiek a ostatných popisov v mapovom poli.

Orientačná šípka9.	  je grafické vyjadrenie orientácie mapy k svetovým stranám, naj-
častejšie k severu.

Mierka mapy10.	  definuje pomer zmenšenia grafických rozmerov objektu na mape 
voči skutočnosti. Čitateľovi pomáha vytvárať predstavu o podrobnosti mapy. Čísel-
ná mierka udáva číselné zmenšenie objektov (ale aj dĺžok) na mape v tvare 1 : M, 
kde M je mierkové číslo. Napr. 1 cm na mape v mierke 1 : 50 000 je v teréne 50 000 
cm (500 m - 0,5 km), v mierke 1 : 200 000 je v teréne 200 000 cm (2 000 m - 2 km). 
Grafická mierka vyjadruje mieru zmenšenej skutočnosti pomocou úsečky, ktorá má 
svoje dĺžkové hodnoty.
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